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Documentation Updates

This manual’s title page contains the following identifying information:

• Software version number, which indicates the software version

• Document release date, which changes each time the document is updated

• Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://ovweb.external.hp.com/lpe/doc_serv/

http://ovweb.external.hp.com/lpe/doc_serv/
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Support

You can visit the HP Software Support Web site at: www.hp.com/go/hpsoftwaresupport

HP Software online support provides an efficient way to access interactive technical support 
tools. As a valued support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require a support contract. To find more information about access levels, go to:  
http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to:  
http://h20229.www2.hp.com/passport-registration.html 

http://www.hp.com/go/hpsoftwaresupport
http://h20230.www2.hp.com/new_access_levels.jsp
http://h20229.www2.hp.com/passport-registration.html
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Welcome to This Guide

Welcome to QuickTest Professional Web Add-in Extensibility. 

QuickTest Professional Web Add-in Extensibility is a Software Development 
Kit (SDK) that enables you to support testing applications that use third-
party and custom Web controls that are not supported out-of-the-box by the 
QuickTest Professional Web Add-in.

The QuickTest Professional Web Add-in Extensibility SDK provides the 
following:

➤ An API that enables you to extend the QuickTest Professional Web Add-in to 
support custom Web controls

➤ The online Web Add-in Extensibility Help, which includes the following:

➤ A Developer’s Guide

➤ An API Reference

➤ A Toolkit Configuration Schema Help

➤ The QuickTest Test Object Schema Help

➤ A printer-friendly (PDF) version of the Developer’s Guide

➤ Sample Web Add-in Extensibility toolkit support sets that extend QuickTest 
support for the following environments:

➤ The ASP .NET AJAX control toolkit 

➤ A sample Web toolkit that includes controls named Book and 
UsedBooksTable
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This chapter includes:

 ➤  How This Guide Is Organized on page 8

 ➤  Who Should Read This Guide on page 10

 ➤  QuickTest Professional Online Documentation on page 10

 ➤  Additional Online Resources on page 12

 ➤  Typographical Conventions on page 14

How This Guide Is Organized

This guide explains how to set up the QuickTest Professional Web Add-in 
Extensibility SDK and use it to extend QuickTest support for third-party and 
custom Web controls. 

This guide assumes you are familiar with QuickTest functionality, and 
should be used together with the QuickTest Web Add-in Extensibility Toolkit 
Configuration Schema Help, QuickTest Professional Web Add-in Extensibility API 
Reference, and the QuickTest Test Object Schema Help that are provided in 
online Help format with the SDK installation (Start > Programs > QuickTest 
Professional > Extensibility > Documentation > Web Add-in Extensibility 
Help).

These documents should also be used in conjunction with the HP QuickTest 
Professional User’s Guide, the QuickTest Professional Web Add-in Guide, and the 
HP QuickTest Professional Object Model Reference (available with the QuickTest 
Professional installation). 

This guide contains:

 Part I Working with Web Add-in Extensibility 

Explains how to use QuickTest Professional Web Add-in Extensibility to 
extend QuickTest support for custom Web controls. This part includes:

➤ Introducing QuickTest Professional Web Add-in Extensibility

➤ Installing the QuickTest Professional Web Add-in Extensibility SDK

➤ Planning QuickTest Support for Your Toolkit
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➤ Developing Support for Your Toolkit

➤ Deploying the Toolkit Support Set

 Part II Tutorial: Learning to Create Web Custom Toolkit Support 

Guides you step-by-step through the process of creating custom support for 
some sample controls. This part includes:

➤ Learning to Create QuickTest Support for a Simple Custom Web Control

➤ Learning to Create QuickTest Support for a Complex Custom Web Control

 Part III API Reference

Explains the methods exposed by the Web Add-in Extensibility 
IControlImplUtils utility object interface, and describes the syntax of these 
methods.

 Part IV Toolkit Configuration Schema Help

Explains the elements and attributes that you define in a toolkit 
configuration file.

 Part V QuickTest Test Object Schema Help

Explains the elements and attributes that you use in a test object 
configuration file to define the test object model for supporting your toolkit.

Note: The information, examples, and screen captures in this guide focus 
specifically on working with QuickTest tests. However, much of the 
information applies equally to components.

Business components and scripted components are part of HP Business 
Process Testing, which utilizes a keyword-driven methodology for testing 
applications. For more information, see the HP QuickTest Professional User’s 
Guide and the HP QuickTest Professional for Business Process Testing User’s 
Guide.

WebExtAPIRef.chm::/ToolkitInterfaces_P.html
WebToolkitConfigSchema.chm::/Toolkit_xsd.html
TestObjectSchema.chm::/ClassesDefintions_xsd.html
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Who Should Read This Guide

This guide is intended for programmers, QA engineers, systems analysts, 
system designers, and technical managers who want to extend QuickTest 
support for Web custom controls. 

To use this guide, you should be familiar with:

➤ Major QuickTest features and functionality

➤ QuickTest Professional Object Model

➤ QuickTest Professional Web Add-in

➤ XML (basic knowledge) 

➤ Web Programming (HTML and JavaScript)

QuickTest Professional Online Documentation

QuickTest Professional includes the following online documentation:

Readme provides the latest news and information about QuickTest. Choose 
Start > Programs > QuickTest Professional > Readme.

QuickTest Professional Installation Guide explains how to install and set up 
QuickTest. Choose Help > Printer-Friendly Documentation > HP QuickTest 
Professional Installation Guide.

QuickTest Professional Tutorial teaches you basic QuickTest skills and shows 
you how to design tests for your applications. Choose Help > HP QuickTest 
Professional Tutorial.

Product Feature Movies provide an overview and step-by-step instructions 
describing how to use selected QuickTest features. Choose Help > Product 
Feature Movies.

Printer-Friendly Documentation displays the complete documentation set in 
Adobe portable document format (PDF). Online books can be viewed and 
printed using Adobe Reader, which can be downloaded from the Adobe Web 
site (http://www.adobe.com). Choose Help > Printer-Friendly Documentation.

http://www.adobe.com
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QuickTest Professional Help includes:

➤ What’s New in QuickTest Professional describes the newest features, 
enhancements, and supported environments in the latest version of 
QuickTest.

➤ QuickTest User's Guide describes how to use QuickTest to test your 
application.

➤ QuickTest for Business Process Testing User's Guide provides step-by-step 
instructions for using QuickTest to create and manage assets for use with 
Business Process Testing.

➤ QuickTest Professional Add-ins Guide describes how to work with 
supported environments using QuickTest add-ins, and provides 
environment-specific information for each add-in.

➤ QuickTest Object Model Reference describes QuickTest test objects, lists 
the methods and properties associated with each object, and provides 
syntax information and examples for each method and property.

➤ QuickTest Advanced References contains documentation for the 
following QuickTest COM and XML references:

➤ QuickTest Automation provides syntax, descriptive information, and 
examples for the automation objects, methods, and properties. It also 
contains a detailed overview to help you get started writing QuickTest 
automation scripts. The automation object model assists you in 
automating test management, by providing objects, methods and 
properties that enable you to control virtually every QuickTest feature 
and capability.

➤ QuickTest Test Results Schema documents the test results XML 
schema, which provides the information you need to customize your 
test results.

➤ QuickTest Test Object Schema documents the test object XML schema 
schema, which provides the information you need to extend test 
object support in different environments.

➤ QuickTest Object Repository Schema documents the object repository 
XML schema, which provides the information you need to edit an 
object repository file that was exported to XML.
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➤ QuickTest Object Repository Automation documents the Object 
Repository automation object model, which provides the information 
you need to manipulate QuickTest object repositories and their 
contents from outside of QuickTest.

➤ VBScript Reference contains Microsoft VBScript documentation, 
including VBScript, Script Runtime, and Windows Script Host.

To access the QuickTest Professional Help, choose Help > QuickTest 
Professional Help. You can also access the QuickTest Professional Help by 
clicking in selected QuickTest windows and dialog boxes and pressing F1. 
Additionally, you can view a description, syntax, and examples for a 
QuickTest test object, method, or property by placing the cursor on it and 
pressing F1.

Additional Online Resources

Mercury Tours sample Web site is the basis for many examples in this guide. 
The URL for this Web site is newtours.demoaut.com.

Knowledge Base opens directly to the Knowledge Base landing page on the 
Mercury Customer Support Web site. Choose Help > Knowledge Base. The 
URL for this Web site is support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp.

Customer Support Web site accesses the HP Software Support Web site. This 
site enables you to browse the Support Knowledge Base and add your own 
articles. You can also post to and search user discussion forums, submit 
support requests, download patches and updated documentation, and more. 
Choose Help > Customer Support Web site. The URL for this Web site is 
www.hp.com/go/hpsoftwaresupport.

Most of the support areas require that you register as an HP Passport user 
and sign in. Many also require a support contract.

To find more information about access levels, go to:  
http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport user ID, go to:  
http://h20229.www2.hp.com/passport-registration.html 

http://newtours.demoaut.com
http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
http://www.hp.com/go/hpsoftwaresupport
http://h20230.www2.hp.com/new_access_levels.jsp
http://h20229.www2.hp.com/passport-registration.html
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Send Feedback enables you to send online feedback about QuickTest 
Professional to the product team. Choose Help > Send Feedback.

HP Software Web site accesses the HP Software Web site. This site provides 
you with the most up-to-date information on HP Software products. This 
includes new software releases, seminars and trade shows, customer support, 
and more. Choose Help > HP Software Web site. The URL for this Web site 
is www.hp.com/go/software.

http://www.hp.com/go/software
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Typographical Conventions

This guide uses the following typographical conventions:

UI Elements and 
Function Names

This style indicates the names of interface elements on 
which you perform actions, file names or paths, and 
other items that require emphasis. For example, “Click 
the Save button.” It also indicates method or function 
names. For example, "The wait_window statement has 
the following parameters:"

Arguments This style indicates method, property, or function 
arguments and book titles. For example, “Refer to the 
HP User’s Guide.”

<Replace Value> Angle brackets enclose a part of a file path or URL 
address that should be replaced with an actual value. 
For example, <MyProduct installation folder>\bin.

Example This style is used for examples and text that is to be 
typed literally. For example, “Type Hello in the edit 
box.”

CTRL+C This style indicates keyboard keys. For example, “Press 
ENTER.”

[ ] Square brackets enclose optional arguments.

{ } Curly brackets indicate that one of the enclosed values 
must be assigned to the current argument. 

... In a line of syntax, an ellipsis indicates that more items 
of the same format may be included. In a 
programming example, an ellipsis is used to indicate 
lines of a program that were intentionally omitted.

| A vertical bar indicates that one of the options 
separated by the bar should be selected.
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1
Introducing QuickTest Professional Web 
Add-in Extensibility

QuickTest Professional Web Add-in Extensibility enables you to provide 
high-level support for third-party and custom Web controls that are not 
supported out-of-the-box by the QuickTest Professional Web Add-in.

This chapter includes:

 ➤  About QuickTest Professional Web Add-in Extensibility on page 17

 ➤  Identifying the Building Blocks of Web Add-in Extensibility on page 18

 ➤  Deciding When to Use Web Add-in Extensibility on page 20

 ➤  Understanding How to Implement Web Add-in Extensibility on page 28

About QuickTest Professional Web Add-in Extensibility

The QuickTest Professional Web Add-in provides built-in support for a 
number of commonly used Web controls. You use QuickTest Professional 
Web Add-in Extensibility to extend that support and enable QuickTest to 
recognize additional Web controls.

When QuickTest learns an object in an application, it recognizes the object 
as belonging to a specific test object class. This determines the identification 
properties and test object methods of the test object that represents the 
application’s object in QuickTest. 

When QuickTest learns the controls on a Web page without Extensibility, it 
ignores certain types of elements and does not create test objects to 
represent the controls they define. 
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For other Web controls that are not supported out-of-the-box by the Web 
Add-in, QuickTest creates a generic WebElement test object. This type of test 
object might not have certain characteristics that are specific to the Web 
control you are testing. Therefore, when you try to create test steps with this 
test object, the available identification properties and test object methods 
might not be sufficient. 

For example, consider a custom Web control that is a special type of table 
that QuickTest recognizes as a plain WebElement. WebElement test objects 
do not support GetCellData operations. To create a test step that retrieves the 
data from a cell in the table, you would need to create test objects to 
represent each cell in the table, and create a complex test that accesses the 
relevant cell’s test object to retrieve the data.

By creating support for a Web control using Web Add-in Extensibility, you 
can direct QuickTest to recognize the control as belonging to a specific test 
object class, and you can specify the behavior of the test object. You can also 
extend the list of available test object classes that QuickTest is able to 
recognize. This enables you to create tests that fully support the specific 
behavior of your custom Web controls.

Identifying the Building Blocks of Web Add-in Extensibility

The sections below describe the main elements that comprise QuickTest 
object support. These elements are the building blocks of Web Add-in 
Extensibility. By extending the existing support of one or more of these 
elements, you can develop the support you need to create meaningful and 
maintainable tests.

Test Object Classes
In QuickTest, every object in an application is represented by a test object of 
a specific test object class. The test object class determines the list of 
identification properties and test object methods available in QuickTest for 
this test object. The icon used to represent the test object in QuickTest, for 
example in the Keyword View and Object Repository, is also determined by 
the test object class.
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Test Object Names
When QuickTest learns an object, it creates a unique name for each test 
object on the page. A descriptive test object name enables you distinguish 
between test objects of the same class and makes it easier to identify them in 
your object repository and in tests. 

By default, a test object is given the name of its test object class (appended 
with an index if there is more than one test object of the same class on the 
page). In many cases, this is not the ideal name for the custom control. 

The test object name needs to be meaningful to the QuickTest user, 
preferably using terminology that is relevant to your toolkit. QuickTest 
displays this name in the Keyword View, in the Expert View, and in the 
object repository.

Test Object Identification Properties
The test object class used to represent the Web control determines the list of 
identification properties available for the test object. It also determines 
which of these identification properties are used to uniquely identify the 
control, which identification properties are available for checkpoints (in the 
Checkpoint Properties dialog box), and which are selected by default for 
checkpoints. However, the actual values of the identification properties are 
derived from the definition of the Web control. Therefore, several Web 
controls that are represented by test objects from the same test object class 
might have different definitions for the same identification property.

Test Object Methods
The test object class used to represent the Web control determines the list of 
test object methods for a test object. However, the actual behavior of the test 
object method depends on the definition of the specific Web control. This 
means that the same test object method might operate differently for 
different Web controls that are represented by test objects from the same 
test object class.
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Recording Events 
One way to create QuickTest tests is by recording user operations on the 
application. When you start a recording session, QuickTest listens for events 
that occur on objects in the application and registers corresponding test 
steps. The test object class used to represent a Web control determines which 
events QuickTest can listen for on the Web control and what test step to 
record for each event that occurs.

Deciding When to Use Web Add-in Extensibility

The QuickTest Professional Web Add-in provides a certain level of support 
for most Web controls, but ignores controls defined as DIV or SPAN 
elements. Before you extend support for a custom Web control, analyze it 
from a QuickTest perspective to view the extent of this support and to 
decide which elements of support you need to modify.

When you analyze the custom Web control, use the Object Spy, Keyword 
View, Expert View, and the Record option. Make sure you examine each of 
the elements described in “Identifying the Building Blocks of Web Add-in 
Extensibility”, above.

If you are not satisfied with the existing object identification or behavior, 
your Web control is a candidate for Web Add-in Extensibility, as illustrated 
in the following situations:

➤ QuickTest might recognize the control using a test object class that does not 
fit your needs. You can use Web Add-in Extensibility to instruct QuickTest to 
identify the custom control as belonging to a new test object class that you 
create. 

➤ The test object class that QuickTest uses for the control might be 
satisfactory, but you would like to customize the behavior of certain test 
object methods or identification properties. You can use Web Add-in 
Extensibility to create a new test object class that extends the one QuickTest 
uses, override the implementation of these properties and methods with 
your own custom implementation, and instruct QuickTest to use the new 
test object class.
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➤ You might find that the test object names QuickTest generates for all objects 
of a certain control type are identical (except for a unique counter) or that 
the name used for the test object does not clearly indicate the control it 
represents. You can use Web Add-in Extensibility to create a new test object 
class that extends the one QuickTest uses, modify how QuickTest names test 
objects of your new class, and instruct QuickTest to use the new test object 
class.

➤ QuickTest might identify individual sub-controls within your custom 
control, but not properly identify your main control. For example, if your 
main custom control is a digital clock with edit boxes containing the hour 
and minute digits, you might want changes in the time to be recognized as 
SetTime operations on the clock control and not as Set operations on the 
edit boxes. You can use Web Add-in Extensibility to modify how events that 
occur on child controls are treated.

➤ During a record session, when you perform operations or trigger events on 
your control, QuickTest might not record a step at all, or it might record 
steps that are not specific to the control’s behavior. Alternatively, QuickTest 
might record many steps for an event that should be considered a single 
operation, or it might record a step when no step should be recorded. 

You can configure the events you want to record for each type of existing 
Web object by modifying the Web event configuration. For more 
information, see the section on configuring web event recording in the 
HP QuickTest Professional Add-ins Guide.

If Web event configuration does not sufficiently enable you to customize 
recording, for example, if you want to modify the steps that QuickTest 
records when certain events occur, you can use Web Add-in Extensibility.
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Analyzing the Default QuickTest Support and Extensibility 
Options for a Sample Custom Control
The following example illustrates how you can use Web Add-in Extensibility 
to improve the QuickTest support of a custom control. 

The Book control shown below represents a book sold on the Internet. This 
control is not specifically supported on QuickTest.

This control contains information including the title of the book, its 
authors, the price for a new copy of the book, and the lowest price for which 
a used copy can be purchased.

Clicking on the title of the book opens a page with more details about the 
book. Clicking on an author name opens a page with a list of books by the 
same author. Clicking on Used opens a Used Books page, listing all of the 
available used copies of the book, and their prices.
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The Book control is implemented as a Web table, as follows:

<table class="Book">
<tr>

<td class="BookImageCell" rowspan="4">
<a href=".\QtpHistory.htm"> 

<img class="BookImage" alt="Book" src=".\res\Book.jpg"/>
</a>

</td>
<td class="BookCell">

<a class="BookTitle" href=".\QtpHistory.htm" >
The History of QuickTest Professional</a>

</td>
</tr>
<tr>

<td class="BookCell">
By: <a href=".\JaneDoe.htm">Jane Doe</a>, 

<a href=".\JohnDoe.htm">John Doe</a>
</td>

</tr>
<tr>

<td class="BookCell">
</td>

</tr>
<tr>

<td class="BookCell">
New: <strong>59.99$</strong> &nbsp; 
<a href=".\UsedBooks.htm">Used:</a> from <strong>29.99$</strong>

</td>
</tr>

</table>
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Therefore, if you point to this control using the Object Spy, QuickTest 
recognizes it as a WebTable object named according to the title of the book. 
The icon used for the test object is the standard WebTable class icon.
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If you record on the Book control without implementing support for it, the 
Keyword View looks like this:

In the Expert View, the recorded test looks like this:

Note that only simple Click steps are recorded, each attributed to a different 
object defined within the book control. Click operations are recorded 
independently on Web Link test objects with different names, or on the 
Book image test object. These steps are not helpfully meaningful in the 
context of this control. 
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If you use Web Add-in Extensibility to support the Book control, the result is 
more meaningful. QuickTest recognizes the control as a WebExtBook test 
object (still named according to the book title) and uses a different icon. The 
test object properties include relevant information, such as authors and 
min_used_price, which provide the names of all the book’s authors and the 
lowest price for which a used copy can be purchased.
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When you are ready to create a test on the control, the Select, 
GoToAuthorPage, and GoToUsedBookPage methods are supported. These 
methods can be recorded or you can select them manually in the Operation 
column of the Keyword View. When recording a test, both clicking on the 
book’s image and clicking its title result in a Select step being recorded.

You can also create a checkpoint to check the value of identification 
properties, for example, authors (that provides a string comprised of all the 
books authors).

In the Keyword View, a test created by recording the same user operations as 
the test shown above will look like this:

In the Expert View, the test looks like this: 

This test is more meaningful and relevant for the Book control’s 
functionality.
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Understanding How to Implement Web Add-in Extensibility

Using Web Add-in Extensibility, you can implement full support for all 
QuickTest features for your controls. You can implement Web Add-in 
Extensibility support for a set of controls (also referred to as a toolkit or 
custom toolkit) by developing a toolkit support set.

Implementing Web Add-in Extensibility consists of the following stages:

 1 Planning the Toolkit Support Set

➤ Determine the set of Web controls that comprise your custom toolkit.

➤ Define the test object model by determining which test objects and 
operations you want to support based on the controls and business 
processes supported by your toolkit.

For more information, see “Planning QuickTest Support for Your Toolkit” on 
page 51.

 2 Developing the Toolkit Support Set

A Web Add-in Extensibility toolkit support set is comprised of the following 
files:

➤ One test object configuration file, which describes the test object model 
for your toolkit to QuickTest.

➤ One toolkit configuration file, which describes which test object class 
represents each control in the toolkit and how QuickTest interacts with 
each control.

➤ One or more files containing JavaScript functions that QuickTest can call 
to perform operations on the custom controls.

For more information, see “Developing Support for Your Toolkit” on 
page 59.
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 3 Deploying the Toolkit Support Set

To deploy your toolkit support set and enable QuickTest to support your 
controls, you need to copy the files you created to specific locations within 
the QuickTest installation folder. 

After you deploy the toolkit support set, when QuickTest opens, it displays 
your toolkit name as a child node under the Web Add-in node in the Add-in 
Manager. If you select the check box for your toolkit, QuickTest supports the 
controls in this toolkit using the toolkit support set that you developed.

For more information, see “Deploying the Toolkit Support Set” on page 101.

 4 Enhancing the Toolkit Support Set

After you have created and tested basic Web Add-in Extensibility support for 
your controls you can enhance your toolkit support set by using some of the 
more complex options to fine-tune your support.

When you develop a Web Add-in Extensibility toolkit support set, you can 
start by creating a simple and basic support set and deploying it to 
QuickTest. This enables QuickTest to recognize your controls correctly and 
enables QuickTest user to create and run tests on the controls. You can then 
enhance your support to enable more complex capabilities, such as filtering 
the child objects learned with a control and more advanced handling of 
events when recording a test.

You can learn how to develop a toolkit support set hands-on, by performing 
the lessons in “Tutorial: Learning to Create Web Custom Toolkit Support” 
on page 105.

For more information, see “Developing Support for Your Toolkit” on 
page 59. 
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2
Installing the QuickTest Professional Web 
Add-in Extensibility SDK

This chapter describes the installation process for the QuickTest Professional 
Web Add-in Extensibility SDK and the content of the SDK.

This chapter includes:

 ➤  About Installing the QuickTest Professional Web Add-in Extensibility SDK 
on page 31

 ➤  Installing the QuickTest Professional Web Add-in Extensibility SDK 
on page 33

 ➤  Repairing the QuickTest Professional Web Add-in Extensibility SDK 
Installation on page 40

 ➤  Uninstalling the QuickTest Professional Web Add-in Extensibility SDK 
on page 45

About Installing the QuickTest Professional Web Add-in 
Extensibility SDK

The Web Add-in Extensibility API is an intrinsic part of QuickTest and does 
not require any additional installation. The QuickTest Professional Web 
Add-in Extensibility SDK installation provides the Web Add-in Extensibility 
documentation and samples of completed toolkit support sets. 

After you install the SDK, you can access the documentation from Start > 
Programs > QuickTest Professional > Extensibility > Documentation. You can 
use the sample toolkit support sets to learn more about implementing Web 
Add-in Extensibility.
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Installing the QuickTest Professional Web Add-in Extensibility SDK on a 
QuickTest computer enables you to work more efficiently when debugging 
and testing your custom toolkit support. However, you can also install and 
use the SDK on a computer without QuickTest. You can create the toolkit 
support set for your Web controls on any computer. To test and debug the 
toolkit support set you must deploy it to QuickTest. For more information, 
see “Deploying the Toolkit Support Set” on page 101.

Using the Web Add-in Extensibility Samples
The Web Add-in Extensibility samples are installed in the following 
locations:

➤ The Book application is installed in <QuickTest Professional Web Add-in 
Extensibility SDK installation folder>\samples\WebExtSample\Application. 
You can run this application from Start > Programs > QuickTest Professional 
> Extensibility > Samples > Web Add-in Extensibility Book Sample.

➤ The toolkit support set for the Book application is installed in <QuickTest 
Professional Web Add-in Extensibility SDK installation 
folder>\samples\WebExtSample\Toolkit Support Set.

In Part II, “Tutorial: Learning to Create Web Custom Toolkit Support”, you 
create a similar toolkit support set for the Book application and deploy it to 
QuickTest.

➤ The toolkit support set for the ASP .NET AJAX control toolkit is installed in 
<QuickTest Professional Web Add-in Extensibility SDK installation 
folder>\dat\Extensibility\Web (and in the Toolkits subfolder within this 
folder). The toolkit support set includes a Help file that describes the test 
objects that represent the ASP .NET AJAX controls and the test object 
methods and properties available for these test objects.

Note: The sample toolkit support set for the ASP .NET AJAX controls toolkit 
does not support recording on the ASPAjaxSlider, ASPAjaxReorderList, and 
ASPAjaxResizableControl test object classes, due to a Web Add-in 
Extensibility limitation.
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If you install the Web Add-in Extensibility SDK in the QuickTest installation 
folder on a computer on which QuickTest is installed, the toolkit support set 
for the ASP .NET AJAX control toolkit is deployed to QuickTest. When you 
open QuickTest, the ASPAjax environment is displayed in the Add-in 
Manager dialog box. You can select the check box for this environment, 
instructing QuickTest to load the support for the ASP .NET AJAX control 
toolkit, or you can clear the check box for the ASPAjax environment and see 
how QuickTest recognizes the ASP .NET AJAX controls without Extensibility 
support. 

If you do not install the Web Add-in Extensibility SDK in the QuickTest 
installation folder, you can manually deploy the ASPAjax toolkit support set 
to QuickTest. To deploy the toolkit support set, you must copy the relevant 
files from <QuickTest Professional Web Add-in Extensibility SDK installation 
folder>\dat\Extensibility\Web to the <QuickTest Professional installation 
folder>\dat\Extensibility\Web folder. 

For more information, see “Deploying the Toolkit Support Set” on page 101.

Installing the QuickTest Professional Web Add-in 
Extensibility SDK

Use the QuickTest Professional Setup program to install the QuickTest 
Professional Web Add-in Extensibility SDK on your computer.

Note: You must be logged on with Administrator privileges to install the 
QuickTest Web Add-in Extensibility SDK.
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To install the QuickTest Professional Web Add-in Extensibility SDK:

 1 Insert the QuickTest Professional DVD into the CD-ROM/DVD drive. The 
QuickTest Professional Setup window opens. (If the window does not open, 
browse to the DVD and double-click setup.exe from the root folder.)
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 2 Click Add-in Extensibility SDKs. The Add-in Extensibility SDKs screen opens. 
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 3 Click QuickTest Professional Web Add-in Extensibility SDK Setup. 

The Welcome screen of the QuickTest Professional Web Add-in Extensibility 
SDK Setup Wizard opens.

Note: If the wizard screen that enables you to select whether to repair or 
remove the SDK installation opens, the QuickTest Professional Web Add-in 
Extensibility SDK is already installed on your computer. Before you can 
install a new version, you must first uninstall the existing one, as described 
in “Uninstalling the QuickTest Professional Web Add-in Extensibility SDK” 
on page 45.
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 4 Click Next. The License Agreement screen opens. 

Read the license agreement and select I Agree. 
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 5 Click Next. The Select Installation Folder screen opens. 

➤ This screen displays the location in which the QuickTest Professional 
Web Add-in SDK will be installed.

To select a different location for the installation, click Browse, choose a 
folder, and then click OK.

Important: If you are installing the Web Add-in Extensibility SDK on a 
QuickTest computer, install the SDK in the QuickTest installation folder. 
This deploys the toolkit support set for the ASP .NET AJAX control toolkit 
to QuickTest, enabling you to load QuickTest support for this toolkit 
from the QuickTest Add-in Manager dialog box.
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➤ If you click Disk Cost, a window opens displaying the amount of free disk 
space on your computer and the amount required for this installation. 
The space required for the installation includes space required for the 
QuickTest Professional Web Add-in Extensibility SDK files and folders (on 
the disk that you select for this installation) and additional space 
required on the system disk (the disk on which the operation system is 
installed), which is used only during the installation process.

➤ Select Just me if you want to limit the access to the QuickTest 
Professional Web Add-in Extensibility SDK you are installing. Otherwise, 
select Everyone to enable anyone who uses this computer to use the SDK.

 6 Click Next. The setup program installs the QuickTest Professional Web 
Add-in SDK and opens the Installation Complete screen. 
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 7 In the Installation Complete screen, if you select the Show Readme check 
box, the QuickTest Professional Web Add-in Extensibility Readme file opens 
after you click Close. The Readme file contains the latest technical and 
troubleshooting information. To open the Readme file at another time, 
select Start > Programs > QuickTest Professional > Extensibility > 
Documentation > Web Add-in Extensibility Readme. 

Click Close to exit the setup wizard.

Repairing the QuickTest Professional Web Add-in 
Extensibility SDK Installation

Your QuickTest Professional DVD enables you to repair an existing 
QuickTest Professional Web Add-in SDK installation by replacing any 
missing or damaged files from your previous installation.

Note: To use the QuickTest Professional DVD to repair an installation, you 
must use the same DVD that you used for the original installation.
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To repair the QuickTest Professional Web Add-in Extensibility SDK 
installation:

 1 Insert the QuickTest Professional DVD into the CD-ROM/DVD drive. The 
QuickTest Professional Setup window opens. (If the window does not open, 
browse to the DVD and double-click setup.exe from the root folder.) 
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 2 Click Add-in Extensibility SDKs. The Add-in Extensibility SDKs screen opens. 
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 3 Click QuickTest Professional Web Add-in Extensibility SDK Setup. The Web 
Add-in Extensibility SDK Setup Wizard opens, enabling you to select 
whether to repair or remove the SDK installation. 



Chapter 2 • Installing the QuickTest Professional Web Add-in Extensibility SDK

44

 4 Select Repair and click Finish. The Setup program replaces the QuickTest 
Professional Web Add-in Extensibility SDK files and opens the Installation 
Complete screen. 

 5 In the Installation Complete screen, click Close to exit the Setup wizard.
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Uninstalling the QuickTest Professional Web Add-in 
Extensibility SDK

You can uninstall the QuickTest Professional Web Add-in SDK by using 
Add/Remove Programs as you would for other installed programs. 
Alternatively, you can use the setup program on the QuickTest Professional 
DVD.

Note: 

➤ You must use the same DVD that you used for the original installation.

➤ You must be logged on with Administrator privileges to uninstall the 
QuickTest Web Add-in Extensibility SDK.
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To uninstall the QuickTest Professional Web Add-in Extensibility SDK:

 1 Insert the QuickTest Professional DVD into the CD-ROM/DVD drive. The 
QuickTest Professional Setup window opens. (If the window does not open, 
browse to the DVD and double-click setup.exe from the root folder.)
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 2 Click Add-in Extensibility SDKs. The Add-in Extensibility SDKs screen opens. 
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 3 Click QuickTest Professional Web Add-in Extensibility SDK Setup. The Web 
Add-in Extensibility SDK Setup Wizard opens, enabling you to select 
whether to repair or remove the SDK. 
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 4 Select Remove and click Finish. The Setup program removes the QuickTest 
Professional Web Add-in Extensibility SDK and opens the Installation 
Complete screen. 

 5 In the Installation Complete screen, click Close to exit the Setup wizard.
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3
Planning QuickTest Support for Your 
Toolkit

Before you begin to create support for a custom toolkit, you must carefully 
plan the support. Detailed planning of how you want QuickTest to 
recognize the custom controls enables you to correctly build the 
fundamental elements of the custom toolkit support. 

This chapter includes:

 ➤  About Planning QuickTest Support for Your Toolkit on page 52

 ➤  Preparing to Create Support for a Custom Toolkit on page 52

 ➤  Determining the Toolkit Related Information on page 53

 ➤  Determining the Support Information for Each Custom Control Type 
on page 54

 ➤  Where Do You Go from Here? on page 58

Note: This chapter assumes familiarity with the concepts presented in 
Chapter 1, “Introducing QuickTest Professional Web Add-in Extensibility.”
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About Planning QuickTest Support for Your Toolkit

Extending the QuickTest Professional Web Add-in’s support to recognize 
custom controls is a process that requires detailed planning. To assist you 
with this, the sections in this chapter include sets of questions related to the 
implementation of support for your custom toolkit and its controls. When 
you create your toolkit support set, you will be implementing it based on 
the answers you provide to these questions.

The first step is determining general information related to your custom 
toolkit, after which you will define the specific information related to each 
control you want to support.

Preparing to Create Support for a Custom Toolkit

Before you begin planning support for custom Web controls, make sure you 
have full access to the controls and understand their behavior. You must 
have an application or Web page in which you can view the controls in 
action, and view the source that implements them.

You do not need to modify any of a custom control’s sources to support it in 
QuickTest, but you do need to be familiar with them. Make sure you know 
what elements and attributes the control comprises, what HTML properties 
it has, the events for which you can listen, and so on.
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Determining the Toolkit Related Information

When you plan your toolkit support set, begin by deciding the general 
toolkit related information: 

➤ Provide a unique name for the toolkit or environment for which you are 
creating support. 

QuickTest displays the name of your environment in all of the dialog boxes 
that display lists of add-ins or supported environments. For example, when 
QuickTest opens, it displays the name of your environment as a child of the 
Web Add-in in the Add-in Manager dialog box and the QuickTest user can 
specify whether to load support for that environment.

➤ Decide which controls this toolkit support set will support. 

➤ Decide what files will contain the JavaScript functions that you write for the 
toolkit support set. 

➤ You can specify one default file for the JavaScript functions that 
implement support for the different QuickTest functionalities and the 
different test object classes. In addition, you can define separate files for 
your implementation functions for the different functionalities and test 
object classes.

➤ You can specify one file that contains common JavaScript functions that 
you call from within others.

➤ Decide whether to use one JavaScript function for the whole toolkit to 
match test object classes to the custom controls. For more information, 
“Teaching QuickTest to Identify the Test Object Class to Use for a Custom 
Web Control” on page 75.

When you design the toolkit support set, you specify this information in the 
toolkit configuration file. For more information, see “Understanding the 
Toolkit Configuration File” on page 71.
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Determining the Support Information for Each Custom 
Control Type

When planning custom support for a specific type of control, carefully 
consider how you want QuickTest to recognize controls of this type—what 
type of test object you want to represent the controls in QuickTest tests, 
which identification properties and test object methods you want to use, 
and so on. Make these decisions based on the business processes that might 
be tested using this type of control and operations that users are expected to 
perform on these controls.

You can run an application containing the custom control and analyze the 
control from a QuickTest perspective using the Object Spy, the Keyword 
View, and the Record option. This enables you to see how QuickTest 
recognizes the control without custom support, and helps you to determine 
what you want to change.

To view an example of analyzing a custom control using QuickTest, see 
“Analyzing the Default QuickTest Support and Extensibility Options for a 
Sample Custom Control” on page 22.

Understanding the Web Add-in Extensibility Planning 
Checklist
When you plan the support for a specific type of control, you must ask 
yourself a series of questions. These are explained below and are available in 
an abbreviated, printable checklist on page 57. 

 1 Make sure you have access to an application that runs the custom control 
on a computer with QuickTest installed.

 2 Is there an existing Web test object class which can be extended to represent 
the custom control? If so, which one? If not, your new test object class 
needs to extend the WebElement class.
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 3 If the new test object class extends a base test object class other than 
WebElement, does the control include an element of the type normally 
represented by the base test object class (also referred to as a base element)? 

➤ If not, you will need to implement all of the test object methods defined 
in the base class and a method that returns values for all of the test class’ 
identification properties.

➤ If the control includes a base element, is it the root Web element of the 
control? 

➤ If it is the root element, QuickTest will use its internal implementation 
for the inherited test object methods and identification properties that 
you do not override. 

➤ If the base element is not the root element, you need to implement a 
JavaScript function that returns the base element.

 4 Define the details for the new test object class that will represent the custom 
control in QuickTest tests:

 a Specify the test object class name.

 b Do you want QuickTest to use a different icon for the new test object? 
If so, make sure the icon file is available in an uncompressed .ico format. 
Recommended location: <QuickTest Professional installation 
folder>\dat\Extensibility\<QuickTest add-in name>\Toolkits\
<Environment name>\res.

 c Specify one or more identification properties that can be used to 
uniquely identify the control (in addition to the test object class).

 d Specify the default test object method to be displayed in the Keyword 
View and Step Generator when a step is generated for a test object of this 
class.

 e Do you want to provide a Help file, which QuickTest will open when F1 
is pressed for test objects of this class in the Keyword View or Expert 
View? 
If so, make sure that the Help file is available in .chm format. 
Recommended location: <QuickTest Professional installation 
folder>\dat\Extensibility\<QuickTest add-in name>\Toolkits\
<Environment name>\help.
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When you design the toolkit support set, you specify this information in the 
test object configuration file. For more information, see “Introducing the 
Custom Toolkit’s Object Model to QuickTest” on page 63.

 5 Which properties will you use to determine what test object class represents 
controls of this type? Decide how to design the process of identifying the 
test object class to use for this control. For more information, see “Teaching 
QuickTest to Identify the Test Object Class to Use for a Custom Web 
Control” on page 75.

 6 Specify the basis for naming the test object that represents the control.

 7 What identification properties do you want to support? Which properties 
should be displayed in the Checkpoint Properties dialog box in QuickTest, 
and which should be selected by default in this dialog box? Which 
identification properties can be used for Smart Identification?

 8 What the test object methods you want to support? Specify the method 
argument types and names, and whether it returns a value in addition to the 
return code.
Optionally, specify the location of a Help file, which QuickTest will open 
when F1 is pressed in the Keyword View or Expert View or the Operation 
Help button is clicked in the Step Generator for a test object method.

 9 Do you want to dynamically provide a list of possible values for any test 
object method arguments? Which?

 10 Which types of children should QuickTest learn with the control?

 11 Should the Object Spy display test objects of this class?

 12 Do you want to provide support for creating QuickTest tests by using the 
Record option?

If so, list the events you want to record on the custom control during a 
QuickTest recording session.

 13 Determine what parts of the support need to be designed in the toolkit 
configuration file and what parts need JavaScript functions.

Note: You can use the checklist on the following page to mark your answers.
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Web Add-in Extensibility Planning Checklist
Use this checklist to plan the support for your custom control.

Custom Control Support Planning Checklist
Specify in 
Toolkit 
XML?

Support by 
JavaScript 
function?

The sources for this custom control are located in: n/a n/a

Specify the Web test object base class that the new test object class 
extends: (Default—WebElement)

n/a n/a

Is the base test object class WebElement? 
Yes/No

If No, is there a base element (an element that matches the base 
test object class)?
Yes/No

If there is a base element, do you need a JavaScript function to 
return it?Yes/No

Yes/No Yes/No

Specify the New Web test object class details:

➤ Test object class name:

➤ Icon file location (optional): 
➤ Identification properties for description:

➤ Default test object method:

➤ Help file location:

n/a n/a

Specify the basis for identifying the test object class to use for the 
control:

Yes/No Yes/No

Specify the basis for naming the test object: n/a Yes

List the identification properties to support. Mark which should 
be available (and which selected by default) for checkpoints and 
which (if any) should be used for Smart Identification:

Yes/No Yes/No
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Where Do You Go from Here?

After you finish planning the custom toolkit support, you create the toolkit 
support set to support the custom toolkit as per your plan. Chapter 4, 
“Developing Support for Your Toolkit” explains how to develop the toolkit 
support set.

List the test object methods to support (if required, include 
arguments, return values, Help file location and Help ID): 

Yes/No Yes/No

Provide a dynamic list of values for any test object method 
arguments?
Yes/No (default)

If so, list the arguments:

n/a Yes/No

Specify the types of children that QuickTest should learn with the 
control:

Yes/No Yes/No

Display test objects of this class in the Object Spy?
Yes (default)/No

Yes/No n/a

Provide support for recording? 
Yes/No

If so, list the events that should trigger recording:

Yes/No Yes/No

Custom Control Support Planning Checklist
Specify in 
Toolkit 
XML?

Support by 
JavaScript 
function?
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4
Developing Support for Your Toolkit

This chapter explains how to create support for a custom Web toolkit. It 
explains what files you have to create for the toolkit support set, the 
structure and content of these files, and how to use them to support the 
different QuickTest capabilities for your environment.

For information on where the toolkit support set files should be stored to 
activate the support you design, see Chapter 5, “Deploying the Toolkit 
Support Set”.

This chapter includes:

 ➤  About Custom Toolkit Support on page 60

 ➤  Creating a Custom Toolkit Support Set on page 61

 ➤  Introducing the Custom Toolkit’s Object Model to QuickTest on page 63

 ➤  Understanding the Toolkit Configuration File on page 71

 ➤  Designing JavaScript Functions for Your Toolkit Support Set on page 73

 ➤  Teaching QuickTest to Identify the Test Object Class to Use for a Custom Web 
Control on page 75

 ➤  Testing the Toolkit Support Set During Development on page 81

 ➤  Logging and Debugging the Custom Support on page 84

 ➤  Implementing Support for Test Object Methods on page 86

 ➤  Implementing Support for Identification Properties on page 92

 ➤  Implementing a Filter for Learning Child Controls on page 95

 ➤  Implementing Support for Recording on page 97
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About Custom Toolkit Support

You implement Web Add-in Extensibility by creating a toolkit support set 
for each Web toolkit you want to support. The toolkit support set is 
comprised of XML configuration files and JavaScript functions. The XML 
configuration files define the test object classes that you create to support 
the custom Web controls and map them to the controls. In addition, they 
define how QuickTest operates on the custom controls. The JavaScript 
functions provide an interface between QuickTest and the application being 
tested, retrieving information about the control and performing operations 
on it.

This chapter describes the different files, definitions, and functions that you 
must include in a custom toolkit support set. For more information, see the 
QuickTest Web Add-in Extensibility Toolkit Configuration Schema Help, the 
QuickTest Web Add-in Extensibility API Reference, and the QuickTest Test Object 
Schema Help (available in the QuickTest Professional Web Add-in 
Extensibility online Help).

The Web Add-in Extensibility SDK provides a sample toolkit support set that 
extends QuickTest support for the ASP .NET AJAX control toolkit. The 
sample also includes a Help file for the test object model that QuickTest uses 
to support testing controls from this toolkit. The toolkit support set files are 
installed in <QuickTest Professional Web Add-in Extensibility SDK 
installation folder>\dat\Extensibility\Web (and in the Toolkits subfolder 
within this folder). You can browse through these files to see examples of 
how Web Add-in Extensibility can be implemented. Some of the examples 
in this chapter are taken from these files.

Note: Before you actually begin to create a toolkit support set, you must 
plan it carefully. For more information, see “Planning QuickTest Support for 
Your Toolkit” on page 51.
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Creating a Custom Toolkit Support Set

A Web Add-in Extensibility toolkit support set is comprised of the following 
files:

➤ One test object configuration file, which describes the test object model 
for your toolkit to QuickTest: The test object classes that QuickTest 
should use to represent controls in your toolkit, and the properties and 
test object methods that need to be supported for the test objects. For 
more information, see “Introducing the Custom Toolkit’s Object Model 
to QuickTest” on page 63.

Note: QuickTest loads of all the test object class definitions (from all of 
the test object configuration files) when it opens, regardless of the 
custom toolkit for which they were created. This enables you to use the 
same test object class definitions when supporting different custom 
toolkits.

➤ One toolkit configuration file, which describes which test object class 
represents each control in the toolkit and how QuickTest interacts with 
each control. For more information, see “Understanding the Toolkit 
Configuration File” on page 71.

➤ One or more files containing JavaScript functions that QuickTest can call 
to retrieve information from or perform operations on the custom 
controls.

➤ Optionally, icon files that contain icons used in QuickTest to represent 
the test object classes that you define, and Help files that describe these 
test object classes and their methods and properties. 

Chapter 5, “Deploying the Toolkit Support Set” describes the names of the 
different files required for a toolkit support set, and the folder structure in 
which they are stored.
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To create a custom toolkit support set:

 1 Choose a unique name to represent the toolkit or environment for which 
you are creating support.

You use the custom toolkit name to compose the name of the toolkit folder 
and the toolkit configuration file. The name must start with a letter and can 
contain only alphanumeric characters and underscores.

Providing unique toolkit names enables a single QuickTest installation to 
support numerous custom toolkit support sets simultaneously. For this 
reason, a name such as MyToolkit is not recommended.

 2 Create a folder for your toolkit support set.

You can choose any convenient name and location for this folder.

 3 Create the following folder structure: <toolkit support set 
folder>\Toolkits\<toolkit environment name>\res.

 4 In the toolkit support set folder, create a file named <toolkit environment 
name>TestObjects.xml. This is the test object configuration file.

 5 In the <toolkit support set folder>\Toolkits\<toolkit environment name> 
folder, create the following:

➤ A file named <toolkit environment name>.xml (this is the toolkit 
configuration file)

➤ One or more files that will contain the JavaScript functions you design

 6 You can use the <toolkit support set folder>\Toolkits\<toolkit environment 
name>\res folder you created to store any icons that you provide to 
represent your test object classes in QuickTest and Help files that describe 
the test objects in your environment.
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Introducing the Custom Toolkit’s Object Model to 
QuickTest

The first stage of developing support for a custom toolkit is to introduce the 
test object model that you want QuickTest to use to test your applications 
and controls. To do this, you define the test object model in the test object 
configuration file. You need to create a test object class for every type of 
custom control for which you want to extend or modify QuickTest support. 
For more information, see “Extending an Existing Test Object Class” on 
page 66 and “Providing a Help File for Customized Test Object Classes” on 
page 70.

In a test object configuration XML, you define the test object classes (for 
example, their identification properties, the test object methods they 
support, and so on). To do this, you define a ClassInfo element for each test 
object class. In addition, you define the name of the environment for which 
the test object classes are intended, and the QuickTest add-in which they 
extend. If the relevant add-in is not loaded when QuickTest opens, 
QuickTest does not load the information in this XML. Similarly, if the 
environment name is displayed in the Add-in Manager dialog box and the 
check box for this environment is not selected, the information in this XML 
is not loaded. 

A test object class definition can include the following:

➤ The name of the new test object class and its attributes, including the base 
class—the test object class that the new test object class extends.
The test object class name must be unique among all of the environments 
whose support a QuickTest user might load simultaneously. For example, do 
not use names of test object classes from existing QuickTest add-ins, such as 
WebButton, WebEdit, Page, etc.

➤ The path of the icon file to use for this test object class (Optional. If not 
defined, a default icon is used.) The icon file must be in an uncompressed 
.ico format.

➤ A context-sensitive Help topic to open when F1 is pressed for the test object 
in the Keyword View or Expert View. The definition includes the Help file 
path and the relevant Help ID within the file. 
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➤ The methods of the new test object, including the following information for 
each method:

➤ The arguments, including the argument type (String or Variant) and 
direction (In or Out).

➤ Whether the argument is mandatory, and, if not, its default value.

➤ Whether a dynamic list of possible values for this argument can be 
retrieved from the supported control and displayed in the Keyword View, 
Expert View, and Step Generator.

➤ The method description (shown as a tooltip in the Keyword View, Expert 
View, and Step Generator).

➤ The Documentation string (shown in the Documentation column of the 
Keyword View and in the Step Generator).

➤ The return value type.

➤ A context-sensitive Help topic to open when F1 is pressed for the test 
object method in the Keyword View or Expert View, or when the 
Operation Help button is clicked for the method in the Step Generator. 
The definition includes the Help file path and the relevant Help ID 
within the file.

➤ The test object method that is selected by default in the Keyword View and 
Step Generator when a step is generated for an object of this class.

➤ The identification properties of the new test object.

➤ The identification properties that are used for the object description.

➤ The identification properties that are used for Smart Identification (Smart 
Identification needs to be enabled for these definitions to take effect).  

➤ The identification properties that are available for use in checkpoints.

➤ The identification properties that are selected by default for checkpoints 
(in the QuickTest Checkpoint Properties dialog box).

For information on the structure and syntax of this XML, see the QuickTest 
Test Object Schema Help, available in the QuickTest Professional Web 
Add-in Extensibility online Help.
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Each time you run QuickTest, it reads all of the test object configuration 
XMLs and merges the information for each test object class from the 
different XMLs into one test object class definition. For more information, 
see “Understanding How QuickTest Merges Test Object Configuration Files” 
on page 68. 

The following example shows the definition of the WebExtUsedBooks test 
object definition, which is part of the WebExtSample toolkit used for the 
tutorial section of this guide:

<ClassInfo BaseClassInfoName="WebTable" GenericTypeID="Table"
DefaultOperationName="SelectBook" 
Name="WebExtUsedBooks">

<IconInfo IconFile="INSTALLDIR\Dat\Extensibility\Web\Toolkits
\WebExtSample\res\WebBookList.ico"/>

<TypeInfo>
<Operation ExposureLevel="CommonUsed" Name="SelectBook"

PropertyType="Method">
<Description>

Selects the radio button for the specified book and clicks Select.
</Description>
<Documentation><![CDATA[Select the radio button for the book with

 index %a1 and click Select.]]></Documentation>
<Argument Name="BookIndex" IsMandatory="true" Direction="In">

<Type VariantType="Integer"/>
</Argument>

</Operation>
</TypeInfo>
<IdentificationProperties>

<IdentificationProperty ForDefaultVerification="true"
ForVerification="true" ForDescription="true" 
Name="title"/>

</IdentificationProperties>
</ClassInfo>

This example shows that the WebExtUsedBooks test object class extends the 
WebTable test object class. The WebExtUsedBooks test object class uses the 
WebBookList.ico icon file, its default test object method is SelectBook 
(which has one Integer mandatory input parameter: BookIndex), and it has 
one additional identification property: title. 
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One identification property is defined for the WebExtUsedBooks test object 
class: title. This identification property is used in the object description, 
available for checkpoints, and selected by default in the Checkpoint 
Properties dialog box in QuickTest.

Extending an Existing Test Object Class
If there is an existing test object class that provides partial support for your 
control, but needs some modification, for example, a different naming 
convention for test objects in the class, or additional or modified test object 
methods, you create a new test object class to represent the control. When 
you create the new test object class, you base this test object class on the 
existing test object class, inheriting all of its test object methods.  

You can then extend the functionality of this test object class by defining 
and implementing additional test object methods and identification 
properties. In addition, you can override existing test object methods by 
providing an alternate implementation for them. You define the new or 
changed methods and properties in the test object configuration file, and 
design their implementation using JavaScript functions.

To extend an existing test object class, you define the name of the base test 
object class in the ClassInfo\BaseClassInfoName attribute in the ClassInfo 
element for the new test object class in the test object configuration file. 
This declares that the new test object class supports all of the test object 
methods of the base test object class in addition to any that you define for 
the new test object class. 

You must ensure that all of the inherited test object methods are 
implemented and not only declared. One way to do this is to write 
JavaScript functions to support each inherited test object method. Another, 
simpler way is to ensure that the control includes an element of the type 
that matches the base test object class. This element is referred to as the base 
element. QuickTest can then use its internal implementation for the 
inherited test object methods that you do not specifically implement for the 
custom control, communicating with the base element. 
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In addition, if the control includes a base element, QuickTest uses the base 
test object class implementation to retrieve the identification property 
values when the following conditions are met:

➤ In the test object configuration file, you defined identification properties for 
the new test object class with the same names as properties of the base test 
object class.

➤ You do not implement a JavaScript function that retrieves the values for 
those properties.

If the base element is the root element of the control that you are 
supporting, QuickTest recognizes the base element and uses the base test 
class implementation for test object methods and identification properties 
that you do not implement. 

If the base element is not the root element of the control, you must write a 
JavaScript function that returns this base element to QuickTest, and specify 
the name and location of the JavaScript function in the toolkit 
configuration file. You specify this information in the Control\Settings 
element in the toolkit configuration file. For example, if your control is a 
special kind of table, and is defined as a DIV element (which QuickTest 
normally ignores) that contains a table element (which QuickTest normally 
represents with a WebTable element), you can create a MyWebTable test 
object class that extends WebTable and map the DIV element to this the 
MyWebTable test object class. To return the base element, you implement a 
JavaScript function named get_base_table in a file named HPTable.js. In the 
toolkit configuration Settings element for the MyWebTable Control 
element, you define the func_to_get_base_elem as follows:

<Control TestObjectClass=MyWebTable>
<Settings>

<Variable name="default_imp_file " value="HPTable.js"/>
<Variable name="func_to_get_base_elem" value="get_base_table"/>

</Settings>
</Control>



Chapter 4 • Developing Support for Your Toolkit

68

Understanding How QuickTest Merges Test Object 
Configuration Files
Each time you open QuickTest, it reads all of the test object configuration 
files located in the <QuickTest installation folder>\dat\Extensibility\
<QuickTest add-in name> folders. QuickTest then merges the information 
for each test object class from the different files into a single test object class 
definition, according to the priority of each test object configuration file.

You define the priority of each test object configuration file using the 
Priority attribute of the TypeInformation element.

Notes: 

➤ If the priority of a test object configuration file is higher than the existing 
class definitions, it overrides any existing test object class definitions, 
including built-in QuickTest information. For this reason, be aware of 
any built-in functionality that will be overridden before you change the 
priority of a test object configuration file.

➤ QuickTest ignores the definitions in a test object configuration files in 
the following situations:
a. The Load attribute of the TypeInformation element is set to false.
b. The environment relevant to the test object configuration file is 
displayed in the Add-in Manager dialog box, and the QuickTest user 
selects not to load the environment.

When multiple test object class definitions exist, QuickTest must handle any 
conflicts that arise. The following sections describe the process QuickTest 
follows when ClassInfo, ListOfValues, and Operation elements are defined in 
multiple test object configuration files. All of the IdentificationProperty 
elements for a specific test object class must be defined in only one test 
object configuration file.
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ClassInfo Elements

➤ If a ClassInfo element is defined in a test object configuration file with a 
priority higher than the existing definition, the information is appended to 
any existing definition. If a conflict arises between ClassInfo definitions in 
different files, the definition in the file with the higher priority overrides 
(replaces) the information in the file with the lower priority.

➤ If a ClassInfo element is defined in a test object configuration file with a 
priority that is equal to or lower than the existing definition, the differing 
information is appended to the existing definition. If a conflict arises 
between ClassInfo definitions in different files, the definition in the file with 
the lower priority is ignored.

ListOfValues Elements

➤ If a conflict arises between ListOfValues definitions in different files, the 
definition in the file with the higher priority overrides (replaces) the 
information in the file with the lower priority (the definitions are not 
merged).

➤ If a ListOfValues definition overrides an existing list, the new list is updated 
for all arguments of type Enumeration that are defined for operations of 
classes in the same test object configuration file.

➤ If a ListOfValues is defined in a configuration file with a lower priority than 
the existing definition, the lower priority definition is ignored.

Operation Elements

➤ Operation element definitions are either added, ignored, or overridden, 
depending on the priority of the test object configuration file.

➤ If an Operation element is defined in a test object configuration file with a 
priority higher than the existing definition, the operation is added to the 
existing definition for the class. If a conflict arises between Operation 
definitions in different files, the definition in the file with the higher 
priority overrides (replaces) the definition with the lower priority (the 
definitions are not merged).
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Providing a Help File for Customized Test Object Classes
As part of the QuickTest Professional online Help, QuickTest provides an 
Object Model Reference for the test object classes that it defines. The 
reference is intended to help the QuickTest users use QuickTest test objects, 
methods, and properties in their tests. In addition, when F1 is pressed for a 
test object or test object method in the Keyword View or Expert View, or 
when the Operation Help button is clicked for a test object method in the 
Step Generator, QuickTest opens the Object Model Reference to the relevant 
location. 

When you modify test object classes or define new ones, using test object 
configuration XML definitions, you can provide similar (.chm) Help files for 
the test objects, methods, and properties that you define. Deploy these Help 
files as part of your toolkit support set and inform the users where they can 
be found. You can store the Help files in any convenient location. For 
example, in a <QuickTest Professional installation 
folder>\dat\Extensibility\<QuickTest add-in name>\Toolkits\
<Environment name>\help folder. In the test object configuration XML, you 
define HelpInfo elements for test object classes and test object methods, 
specifying the Help file path and the relevant Help ID within the file. 

Important: The Help file name must be different from the names of the Help 
files provided in the <QuickTest Professional installation folder>\help 
folder. 

When F1 or the Operation Help button is pressed for a test object class or 
test object method for which you defined a HelpInfo element, QuickTest 
opens the context-sensitive Help topic you specified. For inherited test 
object methods that do not have a HelpInfo element, QuickTest opens the 
Help provided for the base test object class.

In the Help that you provide for your test object classes, it is helpful to 
specify the following information for each test object class:

➤ The base test object class that this test object class extends (include a note 
explaining that the descriptions for inherited test object methods not 
covered in this Help can be found in the Help for the base test object class).
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➤ A list of the available test object methods (including the inherited methods)

➤ Descriptions of the test object methods that you defined, including the 
method’s purpose, syntax, arguments, return value, and any other relevant 
information.

➤ A list of the available identification properties  and descriptions for those 
properties

Understanding the Toolkit Configuration File

To begin developing your toolkit support set, you define a basic toolkit 
configuration file. You can verify the toolkit configuration file you design 
against the <QuickTest Web Add-in Extensibility installation 
folder>\dat\Extensibility\Web\Toolkits\Toolkit.xsd file. (This file is also 
located in the <QuickTest Professional installation 
folder>\dat\Extensibility\Web\Toolkits folder.)

In a toolkit configuration XML, you must define a Control element for each 
test object class that you plan to use to support controls in your toolkit. 
Each Control element must include a TestObjectClass attribute that specifies 
the name of the test object class to which it applies.

The Control elements are contained within one Controls element, which 
represents the toolkit as a whole.

The toolkit configuration file must provide information that enables 
QuickTest to identify which test object class to use for each control in the 
toolkit. This information can be provided at toolkit level or at control level, 
as described in the following sections.  

The toolkit configuration XML can also contain additional information. A 
brief summary of the possible content of this XML is provided below and 
more detail on how to design and use the toolkit configuration XML is 
provided in the subsequent sections of this guide. 
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The toolkit specific information can include:

➤ The priority of the toolkit. When QuickTest attempts to identify the test 
object class mapped to a custom control, it searches in the different toolkits 
in the order of their priority (highest priority first).

➤ An identification function (and optionally the name of the file that contains 
the function) used to identify the test object class to use for each control in 
the toolkit.

➤ The name of the default file from which implementation functions are 
called if no file is specifically defined for a test object class.

A test object class element can include:

➤ An identification function (and optionally the name of the file that contains 
the function) or identification conditions used to identify the custom 
controls that should be represented by this test object class.

➤ The name of the default file from which implementation functions are 
called if no file is specifically defined for a function.

➤ A function (and optionally the name of the file that contains that function) 
that returns the element whose test object implements the properties and 
test object methods inherited from the base class and not implemented for 
this control.

➤ The functions (and optionally the name of the file containing those 
functions) that implement the test object methods of this test object class. 
QuickTest calls these functions to perform test steps on the control. If no 
functions are defined, QuickTest calls implementation functions with the 
same name as the test object methods.

➤ The function (and optionally the name of the file containing the function) 
that retrieves the identification properties from the control. If no function is 
defined, QuickTest calls a function named get_property_value.

➤ Elements that indicate whether to use the default Web Event Configuration 
for handling events on the control and its children, and can specify 
functions that QuickTest should run to perform customized event listening 
and handling.

➤ Elements that indicate when to learn the control and its children, and 
optionally, a function that specifies which children to learn.
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➤ Elements that indicate whether to display test objects of this class in the 
Object Spy.

➤ A function (and optionally the name of the file containing the function) 
that retrieves the list of possible values for a test object method argument 
from the control. If no function is defined, QuickTest calls a function named 
get_list_of_values.

Note: When planning the order of the Control elements in this file, consider 
that QuickTest follows this order when searching for a test object class to 
match a control. The first matching test object class is used.

For information on the structure and syntax of this XML, see the Toolkit 
Configuration Schema Help, available in the QuickTest Professional Web 
Add-in Extensibility online Help.

Designing JavaScript Functions for Your Toolkit Support Set

As part of the toolkit support set, you design JavaScript functions that 
QuickTest calls. The Web Add-in Extensibility API provides the following 
conventions, utility object methods and JavaScript functions for you to use 
in the JavaScript functions that you design:

➤ _elem. A token that represents the Web element that QuickTest is currently 
handling. For example, the following JavaScript function returns the value 
of the id identification property of the current Web element: 

function get_property_value(prop)
{

if (prop == "id")
{

return _elem.id;
}

}
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➤ IControlImplUtils. The interface for utility objects whose methods you can 
use to instruct QuickTest to perform different operations. To call methods of 
objects that implement this interface, call _util.<method_name>.

➤ toSafeArray (inArr). A JavaScript function that you can run to convert an 
array variable to the SafeArray type format that is required in some of the 
utility object methods. This JavaScript function is defined in the common.js 
file located in the <QuickTest Web Add-in Extensibility installation folder>\
dat\Extensibility\Web\Toolkits folder (and also in the <QuickTest 
Professional installation folder>\dat\Extensibility\Web\Toolkits folder).

Using the Utility Object Interface
As part of the toolkit support set, you design JavaScript functions that 
QuickTest calls. The IControlImplUtils utility object interface exposes the 
following methods that you can call in the JavaScript functions that you 
design:

➤ Alert (message). Opens a modal message box displaying the specified 
message.

➤ RegisterForEvent (element, eventName, handler, [HandlerParam]). Registers to 
listen for a specific event on a specific Web element. Use this method in a 
JavaScript function that controls listening to events to support recording. 
For more information on developing support for recording, see 
“Implementing Support for Recording” on page 97.

➤ Record (method, arrParams, delay). Adds a step to the test and adds a test 
object to the object repository if it is not already there. Use this method in a 
JavaScript function that records a step in a test after an event occurs on a 
control. For more information on developing support for recording, see 
“Implementing Support for Recording” on page 97.

➤ Report (status, method, arrParams, details). Adds information about the run 
results of a test step to the Test Results. Use this method in a JavaScript 
function that performs a step on a control. For more information on 
developing support for running tests, see “Implementing Support for Test 
Object Methods” on page 86.

WebExtAPIRef.chm::/ToolkitInterfaces~Mercury.QTP.ToolkitManager.IControlImplUtils~Alert.html
WebExtAPIRef.chm::/ToolkitInterfaces~Mercury.QTP.ToolkitManager.IControlImplUtils~RegisterForEvent.html
WebExtAPIRef.chm::/ToolkitInterfaces~Mercury.QTP.ToolkitManager.IControlImplUtils.html
WebExtAPIRef.chm::/ToolkitInterfaces~Mercury.QTP.ToolkitManager.IControlImplUtils~Record.html
WebExtAPIRef.chm::/ToolkitInterfaces~Mercury.QTP.ToolkitManager.IControlImplUtils~Report.html
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➤ LogLine (text, severity). Sends a message to the Event Viewer. Use this 
method to help you analyze the performance of your support set or debug 
its functionality. For more information on using the Event Viewer to debug 
your toolkit support set, see “Logging and Debugging the Custom Support” 
on page 84.

For more information about these utility object methods, see the QuickTest 
Web Add-in Extensibility API Reference (available with the Web Add-in 
Extensibility SDK online Help).

Teaching QuickTest to Identify the Test Object Class to Use 
for a Custom Web Control

After you define the test object classes that you want QuickTest to use to 
represent your controls, you need to map each type of control to a specific 
test object class. 

This identification can be performed using JavaScript functions or condition 
elements that check the control’s properties and determine the test object 
class that should represent it. To improve performance, define the 
identification elements in such a way that JavaScript function calls are 
avoided as much as possible.

WebExtAPIRef.chm::/ToolkitInterfaces~Mercury.QTP.ToolkitManager.IControlImplUtils~LogLine.html
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You provide information enabling QuickTest to identify which test object 
class to use for the different controls in the Controls\CommonIdentification 
element in the toolkit configuration file, or in the Control\Identification 
element. In these elements you can define the following: 

➤ A set of conditions per test object class. When QuickTest handles each 
control, QuickTest checks the control’s HTML properties against the 
conditions you define in each Control element, and locates the first one 
whose conditions the control meets.

➤ One JavaScript identification function for the whole toolkit. When 
QuickTest handles each control, QuickTest calls this function, which checks 
the control’s properties and returns the appropriate test object class.

➤ A JavaScript identification function per test object class. When QuickTest 
handles each control, QuickTest calls each of these JavaScript functions, in 
the order in which the test objects are defined in the toolkit configuration 
file. Each function checks whether the test object class for which it is 
defined should represent the control. QuickTest uses the first test object 
class whose function returns true.

This method of identification should be avoided if possible because it 
significantly affects performance, as it involves many calls to JavaScript 
functions for each control. 

➤ You can also combine the use of conditions and JavaScript functions, 
defining conditions that limit the calls to the JavaScript function you 
define, based on the control’s properties. For more information, see “Using 
the Identification\Conditions Elements” on page 77.

For more information, see “Designing JavaScript Functions for Your Toolkit 
Support Set” on page 73.
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Important: 

➤ If you specify an identification function at the toolkit level (in the 
Controls\CommonIdentification element) and also conditions at the test 
object class level (in the Control\Identification element), QuickTest 
checks the conditions before calling the JavaScript function, to avoid 
unnecessary calls.

➤ If you specify an identification function at the toolkit level (in the 
Controls\CommonIdentification element), QuickTest does not call any 
identification functions specified at the test object class level (in the 
Control\Identification element).

For information on the structure and syntax of the identification elements, 
see the Toolkit Configuration Schema Help, available in the QuickTest 
Professional Web Add-in Extensibility online Help.

After you teach QuickTest to identify the Test Object Class to use for the 
custom control, you can test the basic functionality of your toolkit support 
set. For more information, see “Testing the Toolkit Support Set During 
Development” on page 81.

Using the Identification\Conditions Elements
You can define Conditions elements in the Control\Identification element 
defined for a test object class. This enables QuickTest to identify the controls 
that should be represented by this test object class, based on the control’s 
properties, without calling an identification function. Alternatively, you can 
define an identification function (per test object class or for the whole 
toolkit) and use the conditions to limit the times QuickTest calls the 
function. You do this by defining that the identification function be called 
only in cases when the control’s properties meet certain conditions.
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You compose the Conditions using a set of Condition elements, joined by 
either and or or logic. Each Condition element specifies a certain property of 
the HTML control, and the expected value for that property. The condition 
is met if the value in the control’s property matches the specified value (you 
can specify in the condition whether the value must be equal or not equal to 
the specified value). You can nest Conditions elements to create complex 
logic.

For each set of conditions, that is for each Conditions element, you specify 
one of the following types, instructing QuickTest how to treat the control if 
its properties match the conditions within it:

➤ IdentifyIfPropMatch. If the conditions in this element are met, use the 
current test object class to represent the control.

➤ CallIDFuncIfPropMatch. If the conditions in this element are met, call the 
identification function to check this control. Otherwise, do not use the 
current test object class to represent the control.

➤ SkipIfPropMatch. If the conditions in this element are met, do not use the 
current test object class to represent the control.

Important: 

➤ If a Conditions element of type IdentifyIfPropMatch is defined, it is 
checked before the other types.

➤ If both CallIDFuncIfPropMatch and IdentifyIfPropMatch Conditions 
elements are defined, the Conditions of type IdentifyIfPropMatch take 
precedence.

➤ A Conditions element of type SkipIfPropMatch is checked only if no 
other types of Conditions elements are defined.

➤ If you nest Conditions elements, the type attribute of the nested elements 
is ignored.
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Understanding How HTML Properties are Compared for 
Conditions 

When comparing the value of an HTML property specified in a condition 
with the specified expected value, the following rules apply:

➤ String value comparisons are not case-sensitive. 

➤ When specifying a string value, a regular expression can be provided as the 
expected value. In this case, set the is_reg_exp attribute to true.

➤ Numeric value comparisons simply compare the numeric values.

➤ When comparing a Boolean value, the values true, 1, and yes are all 
considered true. The values false, 0, and no, are all considered false.

➤ If the HTML property that you are checking returns an object, use valid and 
null as the expected values. The property is considered valid if it successfully 
returns an object, and null if it fails to return an object.

➤ Set the equal attribute in the Condition element to false if you want to 
check if the property does not have a certain value.

The following examples illustrate different ways that you can use the 
Conditions element:

Example 1: Identification Function and Conditions

<Identification type="javascript" function="isCalendar">
<Conditions type="CallIDFuncIfPropMatch" logic="or">

<Condition prop_name="CalendarBehavior" expected_value="valid"/>
<Condition prop_name="PopupBehavior" expected_value="valid"/>

</Conditions>
</Identification> 
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Example 2: Conditions Only

<Identification>
<Conditions type="IdentifyIfPropMatch" logic="and">

<Condition prop_name="AccordionBehavior" expected_value="valid"/>
</Conditions>
<Conditions type="SkipIfPropMatch" logic="or">

<Condition prop_name="AccordionBehavior" expected_value="null"/>
</Conditions>

</Identification> 

Example 3: Nested Conditions nodes

<Identification>
<Conditions type="IdentifyIfPropMatch" logic="and">

<Condition prop_name="tagName" expected_value="div"/>
<Conditions logic="or">

<Condition prop_name="id" expected_value="hp_table_1"/>
<Condition prop_name="id" expected_value="hp_table_2"/>

</Conditions>
</Conditions>
<Conditions type=" SkipIfPropMatch" logic="and">

<Condition prop_name="tagName" expected_value="div" equal="false"/>
</Conditions>

</Identification> 

For information on the structure and syntax of the Conditions and 
Condition elements, see the Toolkit Configuration Schema Help, available in 
the QuickTest Professional Web Add-in Extensibility online Help.
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Testing the Toolkit Support Set During Development

After you define your test object model in the test object configuration file, 
and define a basic toolkit configuration file enabling QuickTest to identify 
which test object classes to use for the different controls, you can test the 
existing functionality of the toolkit support set. To do this, you deploy the 
toolkit support set and test how QuickTest interacts with the controls in 
your environment.

After you complete additional stages of developing support for your 
environment, you can deploy the toolkit support set again and test 
additional areas of interaction between QuickTest and your controls 
(learning test objects, running tests, an so on).

To test your toolkit support set after defining the test object classes and 
mapping them to custom Web elements:

 1 In the test object configuration file, set the 
TypeInformation\DevelopmentMode attribute to true, to ensure that 
QuickTest reads all of the test object class information from the file each 
time it opens. When you complete the development of the toolkit support 
set, make sure to set this attribute to false.

 2 Deploy the toolkit support set on a QuickTest computer by copying the files 
of the support set to the correct locations in the QuickTest installation 
folder. For more information, see “Deploying the Toolkit Support Set” on 
page 101.

 3 Open QuickTest. Ensure that the environment name that you defined for 
the toolkit support set is displayed in the Add-in Manager dialog box as a 
child of the Web Add-in. (If the Add-in Manager dialog box does not open 
when you open QuickTest, see the HP QuickTest Professional Add-ins Guide for 
instructions.)

 4 Select the check box for your environment (the Web Add-in is then selected 
automatically) and click OK to load the support for your toolkit.

 5 Open an application with your custom controls. 
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 6 At this point QuickTest can already recognize and learn your controls, and 
you can create test steps with your custom test objects.

 a Use the Object Spy to view the test object properties and test object 
methods that are supported for your controls.  

➤ For each test object class that you defined, the Object Spy displays all 
of the identification properties that you defined in the test object 
configuration file. New identification properties are displayed without 
values because you have not yet implemented methods to retrieve the 
values from the controls. For identification properties that have the 
same names as base test object class properties, QuickTest uses the base 
class implementation to retrieve the property values if the root Web 
element of the control matches the base test object class. For more 
information, see “Implementing Support for Identification Properties” 
on page 92.

➤ The Object Spy displays all of the test object methods available for 
each test object class that you defined to represent your controls. This 
includes test object methods inherited from the base test object class, 
as well as the test object methods that you defined in the test object 
configuration file.

 b Use the Add Objects to Local button in the Object Repository dialog box 
to learn your controls. Ensure that the correct icon is used to represent 
the test object in the object repository.

 c In the Keyword View, create a test step with a test object from a class that 
you defined.

➤ If you defined a default operation for this class, it is displayed in the 
Operation column after you select the test object in the Item column.

➤ The list of available operations in the Operation column reflects the 
definitions in the test object configuration file, and also includes 
operations inherited from the base test object class. 

➤ After you choose an operation, the Value cell is partitioned according 
to the number of arguments of the selected operation, and if you 
defined possible values for the operation (in the ListOfValues element), 
they are displayed in a list. 
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➤ The descriptions and documentation strings you defined for test object 
methods in the test object configuration file are displayed in tooltips and 
in the Documentation column, respectively.

 d In the Expert View, create a test step with a test object from a class that 
you defined. Intellisense displays all of the operations available for the 
test object, and possible input values for these operations, if relevant, 
based on the definitions in the test object configuration file. (Inherited 
test object methods are also displayed.)

 e In the Step Generator, create a test step with a test object from a class that 
you defined. The operations that you defined in the test object 
configuration file are displayed in the Operation list, and the 
descriptions you defined for the operations are displayed as tooltips. 
(Inherited test object methods are also displayed.)

For more information on working with these options in QuickTest, see 
the HP QuickTest Professional User’s Guide.

To test your toolkit support set after developing support for additional 
QuickTest functionality:

 1 Follow steps 1 to 5 in the previous procedure, to deploy the toolkit support 
set, open QuickTest, load the support and run an application with controls 
from your environment.

 2 Depending on the QuickTest functionality for which you are developing 
support, perform the relevant QuickTest operations on the application to 
test that support. For example, learn controls in the application, run a test 
on the application, record test steps on the application and so on.
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Logging and Debugging the Custom Support

When you design the JavaScript functions for your toolkit support set, it is 
recommended to include writing messages to the Windows Event Viewer, to 
assist in debugging any problems that may arise. 

Use the _util.LogLine method to send messages to the Event Viewer. For 
more information, see the QuickTest Web Add-in Extensibility API Reference 
(available with the Web Add-in Extensibility SDK online Help).

You provide the message text and its level of severity, and QuickTest adds 
the toolkit name and a time and date stamp and writes the messages to the 
Event Viewer.

In addition, while recognizing objects supported by Web Add-in 
Extensibility and performing tests on them, QuickTest also writes log and 
error messages to the Event Viewer.

WebExtAPIRef.chm::/ToolkitInterfaces~Mercury.QTP.ToolkitManager.IControlImplUtils~LogLine.html
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To view the messages and analyze the performance of your toolkit support 
set, open the Event Viewer (in Windows XP and Windows 2000, select 
Start > Settings > Control Panel > Administrative Tools > Computer 
Management, expand the Event Viewer node in the Computer 
Management tree) and select the QuickTest node. Double-click a specific 
message to see its text.
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You can filter the messages displayed in the Event Viewer according to 
severity and other message fields. In the Computer Management toolbar, 
select View > Filter. For more information, see the Event Viewer Help (select 
Action > Help in the Event Viewer).

Implementing Support for Test Object Methods

After enabling QuickTest to recognize the custom controls, you must 
provide support for running test object methods. If you try to run a test with 
steps that run on custom test objects before providing implementation for 
these methods, the test fails and a run-time error occurs.
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For each test object method that you defined in the test object configuration 
file, you must write a JavaScript function that QuickTest runs to perform the 
step on the control. In addition to performing the step, you can design the 
JavaScript function to add a line to the test results report, send log messages 
to the Event Viewer, and display messages boxes to the QuickTest user, as 
necessary. For more information, see “Designing JavaScript Functions for 
Your Toolkit Support Set” on page 73.

In the toolkit configuration file, you need to specify the JavaScript file in 
which QuickTest should look for the JavaScript functions and, optionally, 
the name of the function to use for each test object method. 

You can specify a JavaScript file and function for each test object method in 
the toolkit configuration file, or you can define a default JavaScript file per 
toolkit (Controls element) or per test object class (Control element). 
QuickTest uses the default files for all test objects methods for which you do 
not specify an implementation file. By default, QuickTest searches in the 
specified file for a JavaScript function with the same name as the test object 
method. Therefore, you do not need to specify function names in the toolkit 
configuration file, unless you choose to name a function something other 
than the corresponding test object method name. For more information, see 
the Toolkit Configuration Schema Help, available in the QuickTest 
Professional Web Add-in Extensibility online Help.

Important: Do not create JavaScript functions named get_property_values 
or get_list_of_values. These names are reserved for the JavaScript functions 
that QuickTest calls (by default) to retrieve run-time values of test object 
identification properties and lists of possible values for test object method 
arguments.

After you create support for running test object methods, you can run 
QuickTest tests on your custom test objects, and verify that your toolkit 
support set performs correctly. For more information on testing your toolkit 
support set, see “Testing the Toolkit Support Set During Development” on 
page 81.
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The following example is taken from the ASPAjax toolkit support set, which 
includes support for a Select method on the ASPAjaxTabs test object. In the 
ASPAjax test object configuration file, this is declared as follows:

<ClassInfo BaseClassInfoName="WebElement" 
DefaultOperationName="Select"
Name="ASPAjaxTabs">

<TypeInfo>
<Operation ExposureLevel="CommonUsed" Name="Select"

PropertyType="Method">
<Description>Selects the specified tab.</Description>
<Documentation>

<![CDATA[Select the tab with index %a1.]]>
</Documentation>
<Argument Name="Index" IsMandatory="true" Direction="In">

<Type VariantType="Integer"/>
<Description>The index value of the tab to select.</Description>

</Argument>
</Operation>

</TypeInfo>
</ClassInfo> 

In the toolkit configuration file, the Control\Settings element for the 
ASPAjaxTabs test object class is defined as follows:

<Control TestObjectClass="ASPAjaxTabs">
<Settings>

<!-- Indicates the location of the JavaScript file that contains the
     implementation of the script -->
<Variable name="default_imp_file" value="Tabs.js"/>

</Settings>
</Control>

No Run element is defined for this test object class. Therefore, when 
QuickTest runs a step with the Select test object method, QuickTest searches 
in the Tabs.js file (as defined in the toolkit configuration file) for a JavaScript 
function named Select.

In the Tabs.js file, the Select JavaScript function is implemented to accept an 
index and select the tab with that index.
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Supporting Dynamic Lists of Values for Method 
Arguments
When a QuickTest user creates a test step with a test object method, 
QuickTest can display a set of predefined possible values available for the 
arguments of that method. For example, if an argument is a Boolean 
argument, QuickTest can display true and false as the possible values, or, for 
a month argument, QuickTest can display a list of names of all the months. 
However, sometimes, a limited set of possible values for an argument exists, 
but depends on the specific object on which the step is performed. For 
example:

➤ The values that are actually relevant for the Integer row and column 
arguments of the function Table(<table_name>).SetCellData (row, column) 
are limited to the number of rows and columns in the specific table.

➤ The relevant values for the String path argument of the function 
Tree(<tree_name>).Select (path) are limited to the paths that exist in the 
specific tree.

Using extensibility, you can enable QuickTest to dynamically provide a list 
of values for arguments of test object methods. 

To support a dynamic list of values:

 1 In the test object configuration file, set the DynamicListOfValues attribute 
the Argument element to true.

 2 In the toolkit configuration file, you can specify the file name and function 
name of the JavaScript function that QuickTest must call to retrieve the list 
of values. By default, QuickTest requests the list of values by calling the 
get_list_of_values JavaScript function from the default implementation file 
that you specify for the test object class in the default_imp_file variable in 
the Control\Settings element. For more information, see the Toolkit 
Configuration Schema Help, available in the QuickTest Professional Web 
Add-in Extensibility online Help.

QuickTest calls the JavaScript function for every argument whose 
DynamicListOfValues attribute is set to true in the test object configuration 
file. The parameters provided to this function indicate the test object 
method and argument for which the values are being requested.



Chapter 4 • Developing Support for Your Toolkit

90

 3 Write a JavaScript function that accepts the names of the test object method 
and argument and returns a list of values relevant for the specified argument 
on the current element. Return the string values concatenated to one string, 
each value enveloped in quotation marks.

Note: The dynamic list of values is retrieved from the control in the 
application being tested. Therefore, in order to display the dynamic list of 
values, the relevant control must be visible in the application when the test 
is edited.

For example, in the toolkit support set for the WebExtSample environment, 
located in <Web Add-in Extensibility SDK installation folder>\samples\
WebExtSample folder, a dynamic list of values is supported for the 
AuthorName argument in the GoToAuthorPage test object method of the 
test object class WebExtBook. 

➤ In the WebExtSampleTestObjects.xml test object configuration file, the 
argument is defined as follows:

<Operation Name="GoToAuthorPage" PropertyType="Method">
<Description>Opens the Web page for the specified author.</Description>
<Argument Name="AuthorName" IsMandatory="true" Direction="In" 

DynamicListOfValues="true">
<Type VariantType="String"/>
<Description>The author.</Description>

</Argument>
</Operation>
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In the WebExtBook.js file (defined as the default implementation file for the 
WebExtBook test object class in the WebExtSample.xml toolkit 
configuration file) the following JavaScript functions are designed to return 
a list of the book’s authors, each enveloped in quotation marks:

// Dynamic list of values implementation
// ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
function get_list_of_values( method, argIndex )
{

// When creating a step with the GoToAuthorPage test object method, 
// provide a list of the authors of this book, that can be used for the method's 

      // argument.
if (method == "GoToAuthorPage")
{

return get_GoToAuthorPage_list_of_values(argIndex);
}

return null;
}

function get_GoToAuthorPage_list_of_values(argIndex)
{

var arr = new Array();
if( argIndex > 1 )

return toSafeArray(arr);

// Retrieve all authors
var AuthorsCount = 0;
for( var i = 0 ; i < _elem.rows[1].cells[0].children.length ; ++i )
{

if( _elem.rows[1].cells[0].children[i].tagName == "A" )
{

arr[AuthorsCount]="\""+_elem.rows[1].cells[0].children[i].innerText+"\"";
AuthorsCount++;

}
}
return toSafeArray(arr);

}
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Implementing Support for Identification Properties

In the test object configuration file you defined the identification properties 
for your test object classes. When QuickTest runs a test it needs to retrieve 
the values for these properties. QuickTest uses identification property 
run-time values in different test object methods, such as GetROProperty. 
Identification property run-time values are also required for different basic 
capabilities, such as creating checkpoints and outputting values.

To support retrieving the run-time values of identification properties, you 
need to implement a JavaScript function that accepts a PropertyName 
parameter and returns the value of any property QuickTest requests. For 
more information on writing JavaScript functions for Web Add-in 
Extensibility, see “Designing JavaScript Functions for Your Toolkit Support 
Set” on page 73.

QuickTest uses the base test object class implementation to retrieve the 
identification property values when the following conditions are met:

➤ The control includes a base element (for more information, see “Extending 
an Existing Test Object Class” on page 66).

➤ The identification property is defined in the test object configuration file 
with the same name as a base test object class property.

➤ You do not provide a function that returns a value for that identification 
property.

Implement your JavaScript function to return a value for the identification 
properties defined in the test object configuration file in the following 
situations:

➤ Base test object class implementation for retrieving the value for this 
identification property value is not available.

➤ The base test object class implementation does not meet your needs.

By designing the function that returns identification property values to 
return a value for the logical_name property, you can control how QuickTest 
names test objects of this test object class. For more information, see 
“Customizing the Test Object Name” on page 93.
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In the toolkit configuration file, you can specify the JavaScript file in which 
you implemented the JavaScript function that retrieves property values. You 
can also specify the name of the function that you implemented for this 
purpose (in the Control\Run\Properties element). However, if you do not 
specify a function name, QuickTest calls get_property_value (PropertyName) 
and this is the function that you must implement. If you do not specify a 
file name, QuickTest calls the function from the default JavaScript file you 
specified in the Control\Settings element (at the test object class level) or in 
the Controls\Settings element (at the toolkit level). For more information, 
see the Toolkit Configuration Schema Help, available in the QuickTest 
Professional Web Add-in Extensibility online Help.

After you create support for retrieving the run-time values of identification 
properties, you can test that your toolkit support set correctly enables 
QuickTest to run checkpoints on your Web elements, display the property 
values in the Object Spy, and run test steps with the GetROProperty 
operation. For more information on testing your toolkit support set, see 
“Testing the Toolkit Support Set During Development” on page 81.

Customizing the Test Object Name
When QuickTest learns an object, it creates a unique name for each test 
object on the page. A descriptive test object name enables you distinguish 
between test objects of the same class and makes it easier to identify them in 
your object repository and in tests. 

By default, a test object is given the name of its test object class (appended 
with an index if there is more than one test object of the same class on the 
page). In many cases, this is not the ideal name for the custom control. 

The test object name needs to be meaningful to the QuickTest user, 
preferably using terminology that is relevant to your toolkit. QuickTest 
displays this name in the Keyword View, in the Expert View, and in the 
object repository. The test object name is not used for object identification 
and therefore does not have to remain constant in the application.
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For example, the test object name can be language-dependent. The 
QuickTest user can create a test with the application running in one 
language, creating test objects with names in that language. The user can 
then run the test on the same application in another language. The names 
of test objects in the test remain in the original language, but QuickTest can 
correctly recognize the test objects and perform operations on them, based 
on their description. 

To control how QuickTest names test objects of a test object class, design the 
function that returns identification property values to return a value for the 
logical_name property. QuickTest uses this value as the test object name. 

For example, WebExtBook test objects in the WebExtSample environment 
are named based on their book title. The sample toolkit support set for the 
WebExtSample environment is located in <Web Add-in Extensibility SDK 
installation folder>\samples\WebExtSample folder. The WebExtBook.js file 
is defined as the default implementation file in the WebExtSample.xml 
toolkit configuration file. The JavaScript function for returning 
identification property run-time values is defined in the WebExtBook.js file 
as follows:

function get_property_value(prop)
{

if ( prop == "logical_name" || prop == "title" )
// For the "title" identification property, as well as the "logical_name"
// property, return the inner text of the second cell in the first row.
{

return _elem.rows[0].cells[1].innerText;
}

}
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Implementing a Filter for Learning Child Controls

When you instruct QuickTest to learn a Web page, the Define Object Filter 
dialog box opens, enabling you to determine which of the Web page’s 
descendants should be learned with it. When you select All object types, 
instructing QuickTest to learn the custom control with its parent Web page, 
all of the controls contained within your custom control are also learned as 
children of that Web page (and siblings of the control itself). 

In some situations, there is no need to create test objects for all of the 
children of a control. For example, when there are no significant operations 
to perform on the children and no properties to retrieve, or when, for 
testing purposes, operations performed on the children are viewed as 
operations performed on the parent control. For example, on a calculator 
control that contains button controls, there is no need to create test objects 
for the digit buttons. Pressing the digit buttons performs a Set operation on 
the calculator object itself, providing a numeric input for a calculator 
operation.

You can determine which controls QuickTest learns by defining a Learn 
Filter for the test object class you create. You can use the 
Control\Filter\Learn element in the toolkit configuration file to define basic 
filtering, or you can implement complex filters by writing a JavaScript 
function. If you design a filter using a JavaScript function, specify the 
location and name of the function in the toolkit configuration file.

In the toolkit configuration file, in the Control\Filter\Learn element, you 
can define:

➤ Whether to learn controls represented by this test object class. You can also 
specify that QuickTest should learn controls of this type only if they have 
children.

➤ Whether to learn the controls contained within the controls represented by 
this test object class. You can also specify that your JavaScript function 
needs to be called to determine which descendants to learn.

If you write a JavaScript function to implement the filter, the function must 
return a SafeArray containing all of the descendant Web elements that you 
want QuickTest to learn. For more information, see “Designing JavaScript 
Functions for Your Toolkit Support Set” on page 73.
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For more information, see the Toolkit Configuration Schema Help, available 
in the QuickTest Professional Web Add-in Extensibility online Help.

You can see an example of defining Learn Filters in the sample toolkit 
support set for the WebExtSample environment located in <Web Add-in 
Extensibility SDK installation folder>\samples\WebExtSample folder.

➤ The Filter element for the WebExtBook test object class is defined (in the 
WebExtSample.xml file) as follows:

<Filter>
<Learn learn_control="Yes" learn_children="No"/>

</Filter>

This instructs QuickTest to learn WebExtBook test objects without their 
descendants.

➤ The Filter element for the WebExtUsedBooks test object class is defined as 
follows:

<Filter>
<Learn learn_control="Yes" learn_children="CallFilterFunc"

type="javascript" function="GetChildrenToLearn" />
</Filter>

This instructs QuickTest to learn WebExtUsedBooks test objects, and to call 
the CallFilterFunc JavaScript function to determine which descendants to 
learn.

The GetChildrenToLearn JavaScript function is located in the 
WebExtUsedBooks.js file, which is defined as the default implementation 
file in the WebExtSample.xml toolkit configuration file. The 
GetChildrenToLearn JavaScript function returns all of the radio button 
descendants of the used books table control:

function GetChildrenToLearn()
{ // Return all of the radio buttons in the used books table

return toSafeArray( _elem.children[0].getElementsByTagName("input") );
}
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After you implement a Learn Filter, you can instruct QuickTest to learn your 
custom controls, and verify that your toolkit support set correctly controls 
which of the controls’ children are learned. For more information on testing 
your toolkit support set, see “Testing the Toolkit Support Set During 
Development” on page 81.

Implementing Support for Recording

One way to add objects to the object repository and create tests in QuickTest 
is by recording. To record a test, QuickTest registers to listen to events on the 
Web elements, and, when an event occurs, QuickTest adds the relevant step 
to the test. By default, QuickTest uses the standard Web event configuration 
to determine the events to which to listen for each Web element, and the 
steps to record in the test when each event occurs.

If you want to customize recording on a test object class that you defined, 
you must specify the events that you want to record and the steps that you 
want QuickTest to add to the test when those events occur.

For each test object class on which you want to customize recording, define 
a Control\Record\EventListening element in the test object configuration 
file. In this element you can specify whether to use standard Web event 
configuration to handle events on controls represented by this test object 
class. In addition, you can specify whether to use standard Web event 
configuration to handle events that take place on those controls’ children.

In addition to specifying whether QuickTest should use standard Web event 
configuration, you can specify a JavaScript function that provides more 
specific event registration (and optionally, the name of the file containing 
the function). For more information, see the Toolkit Configuration Schema 
Help, available in the QuickTest Professional Web Add-in Extensibility 
online Help.
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In addition to the definitions in the toolkit configuration file, you write the 
following types of JavaScript functions:

➤ One JavaScript function that uses the RegisterForEvent function in the _util 
utility object to register for listening to the correct events on the correct 
elements. The arguments of this function also determine what JavaScript 
functions QuickTest calls when each event occurs. 

QuickTest calls this function after registering to listen to events according to 
the standard Web event configuration. The event registration performed by 
this function overrides any previous registrations for the same events. For 
events not handled by this function the standard registration is used.  

➤ One or more JavaScript functions that handle the events, when they occur, 
by calling the Record function in the _util utility object to inform QuickTest 
what step to add to the test. 

Note: The Record function, and other utility object functions, require a 
SafeArray type argument. To convert an array to a SafeArray, you can use 
the toSafeArray (array) function that Web Add-in Extensibility provides. This 
function is defined in <Web Add-in Extensibility installation 
folder>\dat\Extensibility\Web\Toolkits\common.js (also located in the 
<QuickTest installation folder>\dat\Extensibility\Web\Toolkits folder). 

For information on the syntax of the utility object functions, see the 
QuickTest Web Add-in Extensibility API Reference (available with the Web 
Add-in Extensibility SDK online Help). For more information on writing 
JavaScript functions for Web Add-in Extensibility, see “Designing JavaScript 
Functions for Your Toolkit Support Set” on page 73.

You can see an example of customized recording in the sample toolkit 
support set for the WebExtSample environment located in <Web Add-in 
Extensibility SDK installation folder>\samples\WebExtSample folder. 

WebExtAPIRef.chm::/ToolkitInterfaces~Mercury.QTP.ToolkitManager.IControlImplUtils~RegisterForEvent.html
WebExtAPIRef.chm::/ToolkitInterfaces~Mercury.QTP.ToolkitManager.IControlImplUtils~Record.html
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➤ In the toolkit configuration file, within the Control element for the 
WebExtBook test object class, the following Record\EventListening element 
is defined:

<Record>
<EventListening 

use_default_event_handling_for_children="false" 
use_default_event_handling="false" 
type="javascript" function="ListenToEvents"/>

</Record>

This instructs QuickTest not to use the default Web Event Configuration for 
handling events on the Book control and its children, but to call the 
JavaScript function ListenToEvents. A JavaScript file is not defined, therefore 
QuickTest looks for the JavaScript function in the WebExtBook.js file that is 
specified at the Control level for the WebExtBook test object class.

➤ In the WebExtBook.js file, the following ListenToEvents function is defined:

function ListenToEvents( elem )
{

// Connect to the "Select" event: When the book name or the book icon is
// clicked, call OnSelectClicked.
_util.RegisterForEvent( _elem.rows[0].cells[0].children[0], "onclick" , 

"OnSelectClicked" );
_util.RegisterForEvent( _elem.rows[0].cells[1].children[0], "onclick" , 

"OnSelectClicked" );
}

This function registers QuickTest to listen to click events on the book’s title 
and image. When registering for an event, this function specifies what 
JavaScript function QuickTest must call when the event occurs.
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➤ In the WebExtBook.js file add the following event handler JavaScript 
functions:

function OnSelectClicked( handlerParam , eventObj )
{

// Record the "Select" step
var arr = new Array();
_util.Record( "Select", toSafeArray(arr) , 0 );
return true;

}

This function records the Select test object method on the WebExtBook test 
object when the book title or image is clicked.

After you implement support for recording, you can record a test on 
controls in your environment, and verify that your toolkit support set 
performs correctly. For more information on testing your toolkit support set, 
see “Testing the Toolkit Support Set During Development” on page 81.
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5
Deploying the Toolkit Support Set

The final stage of extending QuickTest support for a custom toolkit is 
deploying the toolkit support set. This means placing all of the files you 
created in the correct locations on a computer with QuickTest installed, 
enabling QuickTest to recognize the controls in the toolkit and run tests on 
them.

While you are developing the toolkit support set, deploying it to QuickTest 
enables you to test and debug the support that you create. After the toolkit 
support set in complete, you can deploy it on any computer with QuickTest 
installed, to serve as a QuickTest add-in.

This chapter includes:

 ➤  About Deploying the Custom Toolkit Support on page 101

 ➤  Deploying the Custom Toolkit Support on page 102

 ➤  Removing Deployed Support on page 103

About Deploying the Custom Toolkit Support

From the QuickTest user’s perspective, after you deploy the toolkit support 
set on a computer on which QuickTest is installed, the toolkit support set 
can be used as a QuickTest add-in.

When QuickTest opens, it displays the environment names of all deployed 
Web Add-in Extensibility toolkit support sets in the Add-in Manager, as 
child nodes beneath the Web Add-in. The QuickTest user can select an 
environment, instructing QuickTest to load support for that environment. 
For more information on the Add-in Manager dialog box, see the 
HP QuickTest Professional Add-ins Guide.
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Deploying the Custom Toolkit Support

To deploy the toolkit support set that you create, you must place the files in 
specific locations within the QuickTest installation folder. The following 
table describes the appropriate location for each of the toolkit support files:

 

File Name Location

<Custom Toolkit Name>TestObjects.xml

Note: This is the recommended file 
name convention. You can have more 
than one test object configuration XML 
file, and name them as you wish.

➤ <QuickTest Installation 
Folder>\dat\Extensibility\Web

➤ <QuickTest Add-in for Quality Center 
Installation Folder>\dat\Extensibility\
Web
(Optional. Required only if QuickTest 
Add-in for Quality Center is installed) 

<Custom Toolkit Name>.xml <QuickTest Installation Folder>\dat\Exte
nsibility\Web\Toolkits\<custom toolkit 
name>

JavaScript files <QuickTest Installation Folder>\dat\Exte
nsibility\Web\Toolkits\<custom toolkit 
name>

Icon files for new test object classes 
(optional)

Must be an uncompressed .ico format 
file, located on the computer on which 
QuickTest is installed, or in an 
accessible network location.

Specify the location in <Custom Toolkit 
Name>TestObjects.xml

Help files for the test object classes 
(optional)

Must be a .chm file, located on the 
computer on which QuickTest is 
installed, or in an accessible network 
location.

Specify the location in <Custom Toolkit 
Name>TestObjects.xml
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Note: 

The recommended location for the toolkit support set icon files is 
<QuickTest Installation Folder>\dat\Extensibility\Web\Toolkits\<custom 
toolkit name>\res. 

The recommended location for the toolkit support set Help files is 
<QuickTest Installation Folder>\dat\Extensibility\Web\Toolkits\<custom 
toolkit name>\help.

In the test object configuration file, you can specify these locations using 
relative paths. For more information, see the QuickTest Test Object Schema 
Help (available with the Web Add-in Extensibility SDK online Help). 

If you modify a deployed toolkit support set, you must reopen QuickTest 
and re-run the Web application for the changes to take effect. 

Removing Deployed Support

When opening QuickTest, the QuickTest user can use the Add-in Manager to 
instruct QuickTest whether to load the support provided for any particular 
environment or toolkit.

If you want to remove support for a custom toolkit from QuickTest after it is 
deployed, you must delete its toolkit configuration file from: 
<QuickTest Installation Folder>\dat\Extensibility\Web\Toolkits\
<custom toolkit name>

If none of the test object class definitions in a test object configuration file 
are used to represent any custom controls (meaning they are no longer 
needed), you can delete the file from: 
<QuickTest Installation Folder>\dat\Extensibility\Web (and <QuickTest 
Add-in for Quality Center Installation Folder>\dat\Extensibility\Web if 
relevant).
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Part II

Tutorial: Learning to Create Web Custom
Toolkit Support



106



107

1
Learning to Create QuickTest Support for 
a Simple Custom Web Control

In this lesson you create support for the Book control in the Web Add-in 
Extensibility Book Sample toolkit. Creating support for the Book control 
requires only minimal customization, allowing you to learn the basics of 
creating a toolkit support set.

The <QuickTest Professional Web Add-in Extensibility SDK installation 
folder>\samples\WebExtSample\Toolkit Support Set folder contains a 
complete toolkit support set for this sample to which you can refer while 
you perform this lesson. 

Before you perform this lesson, ensure that you have read Chapter 1, 
“Introducing QuickTest Professional Web Add-in Extensibility.”

This chapter includes:

 ➤  Preparing for This Lesson on page 108

 ➤  Planning Support for the Web Add-in Extensibility Book Sample Toolkit 
on page 109

 ➤  Developing the Toolkit Support Set on page 118

 ➤  Lesson Summary on page 145
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Preparing for This Lesson

Before you extend QuickTest support for a custom control, you must have 
access to its source file. You do not need to modify any of the custom 
control’s sources to support it in QuickTest, but you do need to be familiar 
with them. Make sure you know what elements and attributes comprise the 
control, the events that might occur on this control, and so on. You use this 
information when you design the support class.

The source file for the Book control is located in <QuickTest Professional 
Web Add-in Extensibility SDK installation folder>\samples\WebExtSample\
Application\Book.htm. 

You can run the control from Start > Programs > QuickTest Professional > 
Extensibility > Samples > Web Add-in Extensibility Book Sample. 

Run the control, open the source file for it and study the control’s behavior 
and implementation.

The Book control contains information including the title of the book, its 
authors, the price for a new copy of the book, and the lowest price for which 
a used copy can be purchased.

Clicking on the title or the image of the book opens a page that can display 
more details about the book (but is not implemented in this sample). 
Clicking on an author name opens a page that can provide a list of books by 
the same author (but is not implemented in this sample). Clicking on Used 
opens a Used Books page, listing all of the available used copies of the book, 
and their prices. The UsedBooks table is a more complex control that you 
will learn to support in the lesson, “Learning to Create QuickTest Support 
for a Complex Custom Web Control” on page 147.
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Planning Support for the Web Add-in Extensibility Book 
Sample Toolkit

In this section, you analyze how QuickTest currently recognizes the Book 
control versus the way it should recognize it, based on your knowledge of 
the control. Next, you determine the answers to the questions in the 
“Understanding the Web Add-in Extensibility Planning Checklist” on 
page 54, and fill in the “Web Add-in Extensibility Planning Checklist” on 
page 116, accordingly.

The best way to do this is to analyze how QuickTest recognizes the Book 
control on the one hand, using the Object Spy, Keyword View, and Record 
option, and on the other hand, to consider how the control is implemented 
and the purposes for which it is used. 

 1 Open QuickTest and Run the Book control.

Open QuickTest and load the Web Add-in.

Close any open instances of the Book control and open it from Start > 
Programs > QuickTest Professional > Extensibility > Samples > Web Add-in 
Extensibility Book Sample. 

 2 Use the Object Spy to view the Book properties and methods.

In QuickTest, choose Tools > Object Spy or click the Object Spy toolbar 
button to open the Object Spy dialog box. Click the Properties tab and 
select Test Object Properties. 

In the Object Spy dialog box, click the pointing hand, then click the Book 
control.
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The Book control is implemented as a Web table, for which QuickTest 
support is built in, therefore it recognizes the control as a WebTable, named 
according to the title of the book. The icon used for the test object is the 
standard WebTable class icon.

Close the Object Spy.

 3 Record operations on the Book control.

In QuickTest, choose Automation > Record and Run Settings to open the 
Record and Run Settings dialog box. In the Web tab, select Record and run 
test on any open browser. Click OK.
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Click the Record button or choose Automation > Record. Click on different 
links in the Book control (you must return to the previous page after each 
click, to return to the Book control): the book title, the image in the control, 
an author name, and the Used link.

With each click, a new step is added to the test:

Click the Stop button or choose Automation > Stop to end the recording 
session.

Only simple Click steps are recorded, each attributed to a different object 
defined within the book control. Click operations are recorded 
independently on Web Link test objects with different names, or on the 
Book image test object. These steps are not helpfully meaningful in the 
context of this control. 

 4 Determine the custom toolkit to which the Book control belongs.

When you extend QuickTest support for a control you always do so in the 
context of a toolkit. For the purpose of this tutorial, two custom Web 
controls are grouped to form the custom toolkit named WebExtSample: 
Book and UsedBooksTable.

In this lesson you create support for the WebExtSample toolkit, initially 
supporting only the Book control.
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 5 Complete the custom class support planning checklist.

The Book control is implemented as Web table, as follows:

<table class="Book">
<tr>

<td class="BookImageCell" rowspan="4">
<a href=".\QtpHistory.htm"> 

<img class="BookImage" alt="Book" src=".\res\Book.jpg"/>
</a>

</td>
<td class="BookCell">

<a class="BookTitle" href=".\QtpHistory.htm" >
The History of QuickTest Professional</a>

</td>
</tr>
<tr>

<td class="BookCell">
By: <a href=".\JaneDoe.htm">Jane Doe</a>, 

<a href=".\JohnDoe.htm">John Doe</a>
</td>

</tr>
<tr>

<td class="BookCell">
</td>

</tr>
<tr>

<td class="BookCell">
New: <strong>59.99$</strong> &nbsp; 
<a href=".\UsedBooks.htm">Used:</a> from <strong>29.99$</strong>

</td>
</tr>

</table>
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This section describes the required support for the Book control, and then 
summarizes the information in the support planning checklist.

 a Choosing the test object class that represents the custom control:

The Book control is implemented as a Web table control to assist in its 
appearance. For the purpose of performing tests on this control, there is 
no need to for QuickTest to recognize the Book control as a table. On the 
other hand, the basic support that QuickTest provides a generic Web 
element, using the WebElement object, is not specific enough for the 
Book control. Therefore, you create a new test object class named 
WebExtBook, which extends WebElement, and teach QuickTest to 
identify this test object class as the one that represents the Book control.

 b Defining how QuickTest will identify which test object class to use to 
represent the control:

If the control’s tagName property is table and its className property is 
Book, use a WebExtBook test object to represent the control. 

 c Deciding the details for the new test object class:

➤ The new test object class is represented by the icon file: 
<QuickTest installation folder>\Dat\Extensibility\Web\Toolkits\
WebExtSample\res\WebBook.ico

➤ No Help file is provided.

➤ The new identification properties to support are: title, authors, price, and 
min_used_price. They should all be displayed (and selected by default) in 
the QuickTest Checkpoint Properties dialog box, none are used for Smart 
Identification.

The identification properties that uniquely define the object are the 
book’s title and the names of its authors.

➤ The name of the test object itself should be the same as its title 
identification property.
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➤ The custom support should include support for the following test object 
methods:

➤ Select. Simulates clicking the book’s title or image. This is the default 
test object method.

➤ GoToAuthorPage. Simulates clicking the specified author name (the 
available author names should be retrieved from the specific control 
during run-time).

➤ GoToUsedBooksPage. Simulates clicking the Used link.

➤ To support a dynamic list of values, you must modify the toolkit 
configuration file (to specify the JavaScript function that provides the 
values) and design the relevant JavaScript functions.

 d Defining which of the control’s children QuickTest should learn when 
learning the control:

For testing purposes, QuickTest should relate to all operations as though 
they are carried out on the Book control itself, even if they are 
technically performed on controls within it. Therefore, none of the 
control’s children need to be learned and represented by test objects.

 e Deciding whether the Object Spy should display WebExtBook test 
objects: Yes.

 f Defining whether to support recording, and what events to record:

Listen to mouse clicks that occur on the following elements in the 
control: title, image, authors, and Used. When a click occurs on one of 
these elements, record the relevant step in the test.

 g Deciding what parts of the support need to be designed in the toolkit 
configuration file and what parts need JavaScript functions:

➤ For the simple Book control, test object class identification is based 
simply on html property values and can therefore be supported using the 
toolkit configuration file without JavaScript functions.

➤ Test object methods and identification properties can be supported by 
JavaScript functions using the default naming convention, therefore no 
changes are required in the toolkit configuration file.
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➤ Instructing QuickTest not to learn the control’s children can be designed 
in the toolkit configuration file and does not require JavaScript 
functions.

➤ To support recording, you modify the toolkit configuration file to turn 
off the default Web Event Configuration and specify the JavaScript 
function that registers QuickTest to listen to the correct event. In 
addition, design one JavaScript function that handles event registration, 
and additional JavaScript functions that instruct QuickTest to record the 
relevant steps when the events occur.

Below, you can see the checklist, completed based on the information 
above.
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Web Add-in Extensibility Planning Checklist

Custom Control Support Planning Checklist
Specify in 
Toolkit 
XML?

Support by 
JavaScript 
function?

The sources for this custom control are located in:
<QuickTest Professional Web Add-in Extensibility SDK installation 
folder>\samples\WebExtSample\Application\Book.htm

n/a n/a

Specify the Web test object base class that the new test object class 
extends: (Default—WebElement)
WebElement

n/a n/a

Is the base test object class WebElement? Yes

If No, is there a base element (an element that matches the base 
test object class)?n/a

If there is a base element, do you need a JavaScript function to 
return it? n/a

No No

Specify the New Web test object class details:

➤ Test object class name:WebExtBook
➤ Icon file location (optional): 

<QuickTest installation folder>\Dat\Extensibility\Web\Toolkits\Web
ExtSample\res\WebBook.ico

➤ Identification properties for description:title, authors
➤ Default test object method:Select
➤ Help file location: n/a

n/a n/a

Specify the basis for identifying the test object class to use for the 
control:
tagName = table, className = Book.

Yes No

Specify the basis for naming the test object:
Use the book title

n/a Yes

List the identification properties to support. Mark which should 
be available (and which selected by default) for checkpoint sand 
which (if any) should be used for Smart Identification:
title, authors, price, min_used_price (all available for checkpoints 
and selected by default, none used for Smart Identification)

No Yes
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List the test object methods to support (if required, include 
arguments, return values, Help file location and Help ID):
Select ()
GoToAuthorPage (AuthorName)
GoToUsedBookPage ()

No Yes

Provide a dynamic list of values for any test object method 
arguments?
Yes

If so, list the arguments:

AuthorName for GoToAuthorPage method

n/a Yes

Specify the types of children that QuickTest should learn with the 
control:
None

Yes No

Display test objects of this class in the Object Spy?
Yes

No n/a

Provide support for recording? 
Yes

If so, list the events that should trigger recording:

Clicks on title, image, author names, and Used

Yes Yes

Custom Control Support Planning Checklist
Specify in 
Toolkit 
XML?

Support by 
JavaScript 
function?
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Developing the Toolkit Support Set

Follow the steps in this section to develop the toolkit support set for the 
WebExtSample toolkit and learn the basics of Web Add-in Extensibility. 
Developing this toolkit support set comprises the following stages:

➤ Stage 1: Creating the Toolkit Support Set, described on page 118

➤ Stage 2: Introducing the WebExtSample Environment to QuickTest, 
described on page 119

➤ Stage 3: Teaching QuickTest to Identify, Spy, and Learn the Book Control, 
described on page 122

➤ Stage 4: Implementing Support for the WebExtBook’s Test Object Methods, 
described on page 126

➤ Stage 5: Implementing Support for the WebExtBook’s Identification 
Properties, described on page 130

➤ Stage 6: Changing the Name of the Test Object, described on page 133

➤ Stage 7: Implementing a Filter to Prevent Learning Child Objects, described 
on page 135

➤ Stage 8: Implementing Support for Recording on the Book Control, 
described on page 137

➤ Stage 9: Implementing Support for Dynamic List of Values for AuthorName, 
described on page 142

Stage 1: Creating the Toolkit Support Set
In this section, you create the files and folders that comprise the toolkit 
support set for the WebExtSample toolkit.

To create the toolkit support set:

 1 Create a folder for your toolkit support set.

You can choose any convenient name and location for this folder. 

 2 In the toolkit support set folder, create a file named 
WebExtSampleTestObjects.xml. This is the test object configuration file.

 3 In the toolkit support set folder, create a folder named Toolkits.
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 4 In the Toolkits folder, create a folder named WebExtSample.

 5 In the Toolkits\WebExtSample folder, create the following:

➤ A file named WebExtSample.xml (This is the toolkit configuration file.)

➤ A file named WebExtBook.js (This is the file for all of the JavaScript 
functions you design to support the Book control.)

➤ A folder named res containing the WebBook.ico icon file (You can copy 
the icon file from <Web Add-in Extensibility installation folder>\
samples\WebExtSample\Toolkit Support Set\Toolkits\WebExtSample\
res.) 

Stage 2: Introducing the WebExtSample Environment to 
QuickTest
In this section, you introduce the WebExtSample environment to QuickTest, 
using the toolkit configuration file and the test object configuration file. 
The first layer of Web Add-in Extensibility is introducing the environment 
to QuickTest. The toolkit configuration file informs QuickTest of the new 
environment (and its name) and the test object configuration file describes 
the test object model that you designed for the environment.

Designing the Toolkit Configuration File

The first role of the toolkit configuration file is informing QuickTest of the 
new supported environment.

To inform QuickTest that a new environment is supported, it is sufficient to 
create a basic toolkit configuration file, whose name is the same as the 
environment name. A basic toolkit configuration file must contain one 
Controls element with at least one Control element (describing one test 
object class). For more information on the elements and attributes in the 
toolkit configuration file, see the QuickTest Web Add-in Extensibility Toolkit 
Configuration Schema Help (available with the Web Add-in Extensibility SDK 
online Help).
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To inform QuickTest about the WebExtSample environment:

Enter the following text in the WebExtSample.xml file that you created in 
“Stage 1: Creating the Toolkit Support Set” on page 118:

<?xml version="1.0" encoding="UTF-8"?>
<Controls>

<Control TestObjectClass="WebExtBook"/>
</Controls>

After you deploy this file to the correct location on a QuickTest computer, 
when QuickTest opens, it displays the WebExtSample environment in the 
Add-in Manager, as a child node beneath the Web Add-in. If you select the 
check box for the WebExtSample, QuickTest loads the support that you 
provide for this environment.

Later in this lesson you will add additional elements within this Control 
element, providing the location of the JavaScript functions that complete 
the toolkit support set and information that provides support for the 
following QuickTest abilities:

➤ Identifying the test object class used to represent the control (to support the 
Object Spy and learning controls)

➤ Filtering child controls when learning the control

➤ Listening to events on the control to record test steps

Designing the Test Object Configuration File

You use the test object configuration file to introduce the WebExtSample 
environment and its test object model to QuickTest.

The PackageName attribute in the TypeInformation element associates this 
test object configuration file (and the test objects defined in it) with the 
WebExtSample environment. If, when QuickTest opens, you do not select 
the WebExtSample environment, QuickTest ignores the test object class 
definitions in this file.

For more information on the elements and attributes in the test object 
configuration file, see the QuickTest Test Object Schema Help (available with 
the Web Add-in Extensibility SDK online Help).
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To define the WebExtSample test object model in the test object 
configuration file:

Enter the text below in the WebExtSampleTestObjects.xml file that you 
created in “Stage 1: Creating the Toolkit Support Set” on page 118. This 
defines the WebExtSample environment and the WebExtBook test object 
class according to the details described in the “Web Add-in Extensibility 
Planning Checklist” on page 116.

<?xml version="1.0" encoding="UTF-8"?>
<TypeInformation Load="true" AddinName="Web" PackageName="WebExtSample">
<ClassInfo BaseClassInfoName="WebElement" 

DefaultOperationName="Select" 
Name="WebExtBook">

<IconInfo IconFile= 
"INSTALLDIR\dat\Extensibility\Web\Toolkits\WebExtSample\res\WebBook.ico"/>

<TypeInfo>
<Operation ExposureLevel="CommonUsed" 

Name="Select" 
PropertyType="Method">

<Description>Selects the book.</Description>
<Documentation><![CDATA[Select the %l book.]]></Documentation>

</Operation>
<Operation ExposureLevel="CommonUsed" 

Name="GoToAuthorPage" 
PropertyType="Method">

<Description>Opens the Web page for the specified author.</Description>
<Documentation><![CDATA[Open the Web page for %a1.]]></Documentation>
<Argument Name="AuthorName" 

IsMandatory="true" Direction="In"
DynamicListOfValues="true">

<Type VariantType="String"/>
<Description>The author.</Description>

</Argument>
</Operation>
<Operation ExposureLevel="CommonUsed" 

Name="GoToUsedBooksPage" 
PropertyType="Method">

<Description>Opens the used books page.</Description>
<Documentation><![CDATA[Open the %l used books page.]]></Documentation>

</Operation>
</TypeInfo>
<IdentificationProperties>

<IdentificationProperty ForDefaultVerification="true" ForVerification="true" 
ForDescription="true" Name="title"/>
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<IdentificationProperty ForDefaultVerification="true" ForVerification="true" 
ForDescription="true" Name="authors"/>

<IdentificationProperty ForDefaultVerification="true" ForVerification="true" 
ForDescription="false" Name="price"/>

<IdentificationProperty ForDefaultVerification="true" ForVerification="true" 
ForDescription="false" Name="min_used_price"/>

</IdentificationProperties>
</ClassInfo>
</TypeInformation>

Stage 3: Teaching QuickTest to Identify, Spy, and Learn 
the Book Control
To support a custom control, QuickTest must be able to identify which test 
object class should represent a given control. Therefore, the most basic 
element of Web Add-in Extensibility is the Identification element, defined 
within each Control element in the toolkit configuration file. Each Control 
element defines a test object class. The Identification element specifies 
which controls should be represented by that test object class.

When QuickTest needs to recognize a control in the application being 
tested, it checks the Identification element defined for each test object class. 
The first test object class whose Identification definition matches the control 
is used to represent the control.

As described in “Planning Support for the Web Add-in Extensibility Book 
Sample Toolkit” on page 109, any control whose tagName property is table 
and whose className property is Book is represented by a WebExtBook test 
object. This can be defined simply in the toolkit configuration file and does 
not require using JavaScript functions.
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To define the identification rules for the WebExtBook test object class:

Replace the text in the WebExtSample.xml file with the following text: 

<?xml version="1.0" encoding="UTF-8"?>
<Controls>

<Control TestObjectClass="WebExtBook">
<Identification>

<Conditions type="IdentifyIfPropMatch" logic="and">
<Condition prop_name="tagName" expected_value="TABLE"/>
<Condition prop_name="className" expected_value="Book"/>

</Conditions>
</Identification>

</Control>
</Controls>

This adds an Identification element to the Control element that defines the 
WebExtBook test object class. The Identification element includes one 
Conditions element that contains two conditions, both of which must be 
met for the control to qualify as a WebExtBook. The Condition elements 
within the Conditions element specify one condition each. In each 
condition, the value of the specified HTML property of the control must 
match (case-insensitive compare) the specified expected value.

For more information on defining the Identification element for a test 
object class, see “Teaching QuickTest to Identify the Test Object Class to Use 
for a Custom Web Control” on page 75 and the QuickTest Web Add-in 
Extensibility Toolkit Configuration Schema Help (available with the Web Add-in 
Extensibility SDK online Help).
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Deploying and Testing the Toolkit Support Set

After defining the WebExtBook test object class in the test object 
configuration file and the identification rules for this test object class in the 
toolkit configuration file, you can already test the effect of using the toolkit 
support set with QuickTest. 

To deploy the toolkit support set:

 1 Copy the WebExtSampleTestObjects.xml file to <QuickTest installation 
folder>\dat\Extensibility\Web.

 2 In the <QuickTest installation folder>\dat\Extensibility\Web\Toolkits 
folder, create a folder named WebExtSample.

 3 Copy the WebExtSample.xml file to the <QuickTest installation 
folder>\dat\Extensibility\Web\Toolkits\WebExtSample folder.

 4 In the <QuickTest installation folder>\dat\Extensibility\Web\Toolkits\
WebExtSample folder, create a folder named res.

 5 Place the WebBook.ico file in <QuickTest installation 
folder>\dat\Extensibility\Web\Toolkits\WebExtSample\res folder.

To test the toolkit support set:

 1 After you deploy the toolkit support set, open QuickTest.

Note: QuickTest reads toolkit support files when it opens. Therefore, if 
QuickTest is open, you must close QuickTest and open it again.

The Add-in Manager dialog box displays the WebExtSample as a child of the 
Web environment in the list of available add-ins. (If the Add-in Manager 
dialog box does not open, see the HP QuickTest Professional Add-ins Guide for 
instructions.)

 2 Select the check box for WebExtSample and click OK. QuickTest opens and 
loads the support you designed.
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 3 Run the sample control from Start > Programs > QuickTest Professional > 
Extensibility > Samples > Web Add-in Extensibility Book Sample. 

Note: QuickTest establishes its connection with an application when the 
application opens. Therefore, if the Book control is open, you must close it 
and run it again. 

 4 Perform the following QuickTest operations on the Book control, to see how 
QuickTest recognizes the control:

➤ Use the Object Spy to view the test object properties and test object methods 
that are supported for the Book control. The test object created for the Book 
control is given the name of its test object class. Later in this lesson, you 
customize your toolkit support set to provide a more specific name.  

➤ Use the Add Objects to Local button in the Object Repository dialog box to 
learn the Book control. Ensure that the correct icon is used to represent the 
test object in the object repository.

➤ In the Keyword View, create a test step choosing the WebExtBook object 
from the object repository in the Item column.

➤ The list of available operations in the Operation column reflects the 
definitions in the test object configuration file. 

➤ After you choose an operation, the Value cell is partitioned according to 
the number of arguments of the selected operation, and if you defined 
possible values for the operation (in the ListOfValues element), they are 
displayed in a list. For example, when you create a step with the 
operation GoToAuthorPage, the value cell requires one argument and 
displays the argument’s Name attribute in a tooltip. The AuthorName 
argument currently accepts any string. Later in this lesson, you develop 
support for dynamically providing a list of the authors that can be used 
for this argument.

➤ The descriptions and documentation strings you defined for test object 
methods in the test object configuration file are displayed in tooltips and 
in the Documentation column, respectively.



Lesson 1 • Learning to Create QuickTest Support for a Simple Custom Web Control

126

➤ In the Expert View, create a test step with a WebExtBook test object. 
Intellisense displays all of the operations available for the test object, and 
possible input values for these operations, if relevant, based on the 
definitions in the test object configuration file. 

For more information on working with these options in QuickTest, see the 
HP QuickTest Professional User’s Guide.

 5 Run a test with a step that performs a test object method on a WebExtBook 
test object. QuickTest searches for a JavaScript function that will run the test 
object method on the control. Because you have not yet implemented 
support for running test object methods, a run-time error occurs. In the next 
section, you implement this support.

Stage 4: Implementing Support for the WebExtBook’s 
Test Object Methods
After enabling QuickTest to recognize the custom controls, you must 
provide support for running test object methods. For each test object 
method that you defined in the test object configuration file, you must 
write a JavaScript function that QuickTest runs to perform the step on the 
control.

In the toolkit configuration file, you need to specify the JavaScript file in 
which QuickTest should look for the JavaScript functions and, optionally, 
the name of the function to use for each test object method. 

In this section, you provide support for the WebExtBook’s test object 
methods: Select, GoToAuthorPage (AuthorName), and GoToUsedBooksPage. 

It is possible to specify a JavaScript file and function for each test object 
method in the toolkit configuration file. However, in this lesson, you 
develop support for running test object methods in the simplest way 
possible. At the Control element level, you define one JavaScript file that 
QuickTest uses by default for all test objects methods defined within this 
element. As for the JavaScript function names, by default, QuickTest 
searches in the specified file for a JavaScript function with the same name as 
the test object method. Therefore, you do not need to specify the function 
names in the toolkit configuration file, but only to create the JavaScript 
functions with the correct names.
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To develop support for the WebExtBook test object methods:

 1 In the WebExtSample.xml file, within the Control element defined for the 
WebExtBook test object class, add the following Settings element:

<Settings>
<Variable name="default_imp_file" value="WebExtBook.js"/>

</Settings>

This instructs QuickTest to search for JavaScript functions in the 
WebExtBook.js file (in the <QuickTest installation 
folder>\dat\Extensibility\Web\Toolkits\WebExtSample folder).

Note: You can modify the WebExtSample.xml file in the toolkit support set 
folder and then later deploy it to QuickTest for testing, or you can modify 
<QuickTest installation folder>
\dat\Extensibility\Web\Toolkits\WebExtSample\WebExtSample.xml 
directly.

 2 In the WebExtBook.js file that you created in “Stage 1: Creating the Toolkit 
Support Set” on page 118, paste the text below to create JavaScript functions 
for each test object method: Select, GoToAuthorPage (AuthorName), and 
GoToUsedBooksPage.

Note: The _elem object is a reserved object that QuickTest uses to refer to the 
HTML control currently being handled.  
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// Run implementation
// ~~~~~~~~~~~~~~~~~~~~~~~~~~~~
// This section contains the functions that carry out the test object methods.

function Select()
{ // Click the link in the second cell of the first row.

_elem.rows[0].cells[1].children[0].click();
}

function GoToAuthorPage(AuthorName)
{ // Look for the specified author name among the children of the first cell 

// in the second row and click it.
var bWasFound = false;
for( var i = 0 ; i < _elem.rows[1].cells[0].children.length ; ++i )
{

if( _elem.rows[1].cells[0].children[i].innerText == AuthorName )
{

_elem.rows[1].cells[0].children[i].click();
bWasFound = true;
break;

}
}
if( bWasFound == false )

throw ("Author name not found !");
}

function GoToUsedBooksPage()
{ // Click the link in the first cell of the third row.

_elem.rows[3].cells[0].children[1].click();
}
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Deploying and Testing the Toolkit Support Set

After developing support for running the test object methods, you deploy 
the updated toolkit support set to QuickTest and test it.

To test the support for running test object methods:

 1 To deploy the updated toolkit support set to QuickTest, copy the 
WebExtBook.js file (and WebExtSample.xml if necessary) to <QuickTest 
installation folder>\dat\Extensibility\Web\Toolkits\WebExtSample.

 2 Close and reopen QuickTest. Select the check box for WebExtSample in the 
Add-in Manager dialog box and click OK. QuickTest opens and loads the 
support you designed.

 3 Close and rerun the sample control from Start > Programs > QuickTest 
Professional > Extensibility > Samples > Web Add-in Extensibility Book 
Sample. 

 4 Use the Add Objects to Local button in the Object Repository dialog box to 
learn the Book control.

 5 Create a test with the following step and then run the test:

Browser("Book").Page("Book").WebExtBook("WebExtBook").GoToAuthorPage 
"Jane Doe"

Note: If you run the GoToAuthorPage test object method with an author 
name that does not exist in the control, the JavaScript function throws an 
exception, QuickTest displays a run-time error message and the test step 
fails.

Create and run similar tests to test the Select and GoToUsedBooksPage test 
object methods.
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Stage 5: Implementing Support for the WebExtBook’s 
Identification Properties
In this section you implement support for retrieving the values of 
identification properties during a test run. QuickTest uses identification 
property run-time values in different standard test object methods, such as 
GetROProperty. Identification property run-time values are also required for 
different basic capabilities, such as creating checkpoints and outputting 
values.

To support retrieving the run-time values of identification properties, you 
need to implement a JavaScript function that accepts a PropertyName 
parameter and returns the value of any property QuickTest requests. You 
must implement this method to return a value for each identification 
property defined in the test object configuration file. 

In the toolkit configuration file, you can specify the JavaScript file in which 
you implemented the JavaScript function that retrieves property values. You 
can also specify the name of the function that you implemented for this 
purpose. However, if you do not specify a function name, QuickTest calls 
get_property_value (PropertyName) and this is the function that you must 
implement. If you do not specify a file name, QuickTest calls the function 
from the JavaScript file you specified in the Control\Settings element. 
Therefore, in this lesson, you create the get_property_value function in the 
WebExtBook.js file.

To support retrieving the run-time values of the WebExtBook’s 
identification properties:

Add the following lines to the WebExtBook.js file:

// Property retrieval implementation
// ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
// The function provides values for all of the identification properties defined in
// the test object configuration XML file.

function get_property_value(prop)
{

if ( prop == "title" )
// For the "title" identification property, 
// Return the inner text of the second cell in the first row



Lesson 1 • Learning to Create QuickTest Support for a Simple Custom Web Control

131

{
return _elem.rows[0].cells[1].innerText;

}

if ( prop == "authors" )
// To return a list of all the authors, look for all the children 
// of the first cell in the second row.
{

var BookAuthors = "";
var AuthorsCount = 0;
for( var i = 0 ; i < _elem.rows[1].cells[0].children.length ; ++i )
{

if( _elem.rows[1].cells[0].children[i].tagName == "A" )
{

if( AuthorsCount > 0 )
BookAuthors += ",";

BookAuthors += _elem.rows[1].cells[0].children[i].innerText;
AuthorsCount++;

}
}
return BookAuthors;

}

if ( prop == "price" )
// To return the price of the book, return the innerText property of the
// first cell in the fourth row.
{

return _elem.rows[3].cells[0].children[0].innerText;
}

if ( prop == "min_used_price" )
// To return the lowest price available for a used copy of the book,
// return the innerText property of the second child of the first cell
// in the fourth row.
{

if( _elem.rows[3].cells[0].children.length > 2 )
return _elem.rows[3].cells[0].children[2].innerText;

}
}
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Note: You can modify the WebExtBook.js file in the toolkit support set 
folder and then later deploy it to QuickTest for testing, or you can modify 
<QuickTest installation folder>
\dat\Extensibility\Web\Toolkits\WebExtSample\WebExtBook.js directly.

Deploying and Testing the Toolkit Support Set

After developing support for retrieving run-time values of identification 
properties, you deploy the updated toolkit support set to QuickTest and test 
it.

To test the support for retrieving run-time values of identification 
properties:

 1 Make sure that your most updated files are located in <QuickTest 
installation folder>\dat\Extensibility\Web\Toolkits\WebExtSample.

 2 Close and reopen QuickTest. Select the check box for WebExtSample in the 
Add-in Manager dialog box and click OK. QuickTest opens and loads the 
support you designed.

 3 Close and rerun the sample control from Start > Programs > QuickTest 
Professional > Extensibility > Samples > Web Add-in Extensibility Book 
Sample. 

 4 Create a new test, add a WebExtBook test object to your object repository, 
and create a test step with this test object. Right-click the object and select 
Insert Standard Checkpoint. The Checkpoint Properties dialog box opens. 
Make sure that the identification properties you defined in the test object 
configuration file (title, authors, price, and min_used_price) are included in 
the list of properties and are selected.
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 5 Create and run a test that retrieves each identification property and checks 
its value, or displays it in a message box. For example, you can run the 
following test:

The first step checks the value of the authors property, the checkpoint in the 
second step checks the properties selected in the checkpoint (in this case 
price and min_used_price) and the third step displays the book’s title in a 
message box.

 6 Click OK to close the message box. The test run is completed and the test 
results are displayed. Expand the test results tree to view the step details.

Stage 6: Changing the Name of the Test Object
In this section, you modify the toolkit support set to instruct QuickTest to 
name the WebExtBook test object according to its title, as per your plan 
(“Planning Support for the Web Add-in Extensibility Book Sample Toolkit” 
on page 109).

When QuickTest creates the test object that represents a control, it calls the 
get_property_value function (used for retrieving test object identification 
property values) with the argument logical_name to determine the name for 
the test object. You can implement the get_property_value function 
accordingly, to customize the name QuickTest gives the test object. If the 
get_property_value function does not support the logical_name property, 
the test object is given the name of the test object class (followed by an 
index, if there is more than one object of the same test object class on the 
same page).
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To customize the name of the test object:

In the get_property_value function in the WebExtBook.js file, replace the 
lines:

if ( prop == "title" )
// For the "title" identification property, 

with the lines:

if ( prop == "logical_name" || prop == "title" )
// For the "title" identification property, as well as the "logical_name" property

Note: You can modify the WebExtBook.js file in the toolkit support set 
folder and then later deploy it to QuickTest for testing, or you can modify 
<QuickTest installation folder>
\dat\Extensibility\Web\Toolkits\WebExtSample\WebExtBook.js directly.

The get_property_value function now returns the same text for the 
logical_name property that QuickTest uses to name the test object, as it does 
for the title identification property. (Modify the comment that explains this 
function accordingly. At the end of the comment, add the following: as well 
as the hard coded "logical_name" property that QuickTest uses to name the test 
object.)

Deploying and Testing the Toolkit Support Set

After developing support for naming the test object that represents the 
control, you deploy the updated toolkit support set to QuickTest and test it.

To test the support for naming the WebExtBook test object:

 1 Make sure that your most updated files are located in <QuickTest 
installation folder>\dat\Extensibility\Web\Toolkits\WebExtSample.

 2 Close and reopen QuickTest. Select the check box for WebExtSample in the 
Add-in Manager dialog box and click OK. QuickTest opens and loads the 
support you designed.
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 3 Close and rerun the sample control from Start > Programs > QuickTest 
Professional > Extensibility > Samples > Web Add-in Extensibility Book 
Sample. 

 4 Open the Object Repository and use the Add Object to Local button to learn 
the Book control. Make sure that the test object that QuickTest creates is 
named The History of QuickTest Professional.

Stage 7: Implementing a Filter to Prevent Learning Child 
Objects
When you instruct QuickTest to learn a Web page, the Define Object Filter 
dialog box opens, enabling you to determine which of the Web page’s 
descendants should be learned with it. When you select All object types, 
instructing QuickTest to learn the WebExtBook control with its parent Web 
page, all of the controls that the WebExtBook control contains are also 
learned as children of that Web page (and siblings of the WebExtBook 
control). 

In the case of the Book control, there is no need to create test objects for all 
of its children, as described in “Planning Support for the Web Add-in 
Extensibility Book Sample Toolkit” on page 109. 

To prevent QuickTest from learning all of the descendants of a control 
supported by Web Add-in Extensibility, you can define a Learn Filter. 
Complex filters can be implemented using a JavaScript function, in which 
case you specify the location and name of the function in the toolkit 
configuration file. Simple filters can be implemented directly in the toolkit 
configuration file, without using JavaScript functions.

To prevent learning the controls contained in the Book control, a simple 
filter is sufficient. Before you implement this filter, learn the Web page that 
contains the Book control with all of its descendants to see that all of the 
Book’s children are learned as well. To do this, you can follow the procedure 
described in “Deploying and Testing the Toolkit Support Set” on page 136.
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To prevent learning the controls contained in the Book control:

In the WebExtSample.xml file, within the Control element defined for the 
WebExtBook test object class, add the following Filter element:

<Filter>
<Learn learn_control="Yes" learn_children="No"/>

</Filter>

This instructs QuickTest to learn WebExtBook test objects when learning 
their parent Web pages, but not to learn the child controls they contain.

Note: You can modify the WebExtSample.xml file in the toolkit support set 
folder and then later deploy it to QuickTest for testing, or you can modify 
<QuickTest installation folder>
\dat\Extensibility\Web\Toolkits\WebExtSample\WebExtSample.xml 
directly.

Deploying and Testing the Toolkit Support Set

After defining the filter to prevent learning children, you deploy the 
updated toolkit support set to QuickTest and test it.

To test the support for learning the WebExtBook test object without its 
children:

 1 Make sure that your most updated files are located in <QuickTest 
installation folder>\dat\Extensibility\Web\Toolkits\WebExtSample.

 2 Close and reopen QuickTest. Select the check box for WebExtSample in the 
Add-in Manager dialog box and click OK. QuickTest opens and loads the 
support you designed.

 3 Close and rerun the sample control from Start > Programs > QuickTest 
Professional > Extensibility > Samples > Web Add-in Extensibility Book 
Sample. 

 4 Open a test and open the Object Repository. Use the Add Objects to Local 
button in the Object Repository dialog box to learn the Web page that 
contains the Book control. The Define Object Filter dialog box opens.
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 5 Select All object types and click OK. The WebExtBook object named The 
History of QuickTest Professional is added to the object repository, but the 
controls in contains are not.

Stage 8: Implementing Support for Recording on the 
Book Control
By this point in the tutorial, your toolkit support set already enables full 
QuickTest functionality. QuickTest recognizes the Book control, can learn it 
and can run tests on it.

An additional, optional way to create tests in QuickTest is by recording 
operations that a user performs on the application. As you can see in 
“Planning Support for the Web Add-in Extensibility Book Sample Toolkit” 
on page 109, by default QuickTest records plain click operations on the 
various Web link and image objects within the Book control. It would be 
more helpful to record Select, GoToAuthorPage, and GoToUsedBooksPage 
operations on the Book control itself, in response to those same clicks.

To support customized recording on your control, you must instruct 
QuickTest to listen to the relevant events and inform QuickTest what test 
steps to record in response to each event. 

To do this you write two types of JavaScript functions:

➤ One JavaScript function uses the RegisterForEvent function in the _util 
utility object that QuickTest exposes in the Web Add-in Extensibility SDK 
to register for listening to the correct events on the correct elements. The 
arguments of this function also determine what JavaScript functions 
QuickTest calls when each event occurs. 

In the toolkit configuration file, you specify the name and, optionally, 
the location of this JavaScript function.

➤ One or more JavaScript functions that handle the events by calling the 
Record function in the _util utility object to inform QuickTest what step 
to add to the test. 
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Note: The Record function, and other utility object functions, require a 
SafeArray type argument. To convert an array to a SafeArray, you can use 
the toSafeArray (array) function that Web Add-in Extensibility provides. 
This function is defined in <Web Add-in Extensibility installation 
folder>\dat\Extensibility\Web\
Toolkits\common.js.

For information on the syntax of the utility object functions, see the 
QuickTest Web Add-in Extensibility API Reference (available with the Web 
Add-in Extensibility SDK online Help). 

To develop support for recording on the Book control:

Note: You can modify the WebExtSample.xml and WebExtBook.js files in 
the toolkit support set folder and then later deploy them to QuickTest for 
testing, or you can modify these files in <QuickTest installation folder>
\dat\Extensibility\Web\Toolkits\WebExtSample directly.

 1 In the toolkit configuration file, within the Control element add the 
following Record\EventListening element:

<Record>
<EventListening 

use_default_event_handling_for_children="false" 
use_default_event_handling="false" 
type="javascript" function="ListenToEvents"/>

</Record>

This instructs QuickTest not to use the default Web Event Configuration for 
handling events on the Book control and its children, but to call the 
JavaScript function ListenToEvents. Because you did not specify a JavaScript 
file, QuickTest looks for the JavaScript function in the WebExtBook.js file 
that you specified at the Control level for the WebExtBook test object class.
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 2 In the WebExtBook.js file, add the following ListenToEvents function:

function ListenToEvents( elem )
{

// Connect to the "Select" event: When the book name or the book icon is
// clicked, call OnSelectClicked.
_util.RegisterForEvent( _elem.rows[0].cells[0].children[0], "onclick" , 

"OnSelectClicked" );
_util.RegisterForEvent( _elem.rows[0].cells[1].children[0], "onclick" , 

"OnSelectClicked" );

// Connect to the "Author" event: When an author name is clicked, call
// OnAuthorClicked.
for( var i = 0 ; i < _elem.rows[1].cells[0].children.length ; ++i )
{

if( _elem.rows[1].cells[0].children[i].tagName == "A" )
{

_util.RegisterForEvent( _elem.rows[1].cells[0].children[i], "onclick" , 
"OnAuthorClicked" );

}
}

// Connect to the "UsedBooks" event: When "Used" is clicked, call
// OnUsedBooksClicked.
if(  _elem.rows[3].cells[0].children.length > 1 )

_util.RegisterForEvent( _elem.rows[3].cells[0].children[1], "onclick" , 
"OnUsedBooksClicked" );

return true;
}

This function registers QuickTest to listen to click events on the book’s title, 
image, and authors, and on the Used link. When registering for an event, 
this function specifies what JavaScript function QuickTest must call when 
the event occurs.
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 3 In the WebExtBook.js file add the following event handler JavaScript 
functions:

function OnSelectClicked( handlerParam , eventObj )
{

// Record the "Select" step
var arr = new Array();
_util.Record( "Select", toSafeArray(arr) , 0 );
return true;

}

function OnAuthorClicked( handlerParam , eventObj )
{

// Record the "GoToAuthorPage" step
var arr = new Array();
arr[0] = eventObj.srcElement.innerText; 
_util.Record( "GoToAuthorPage", toSafeArray(arr) , 0 );
return true;

}

function OnUsedBooksClicked( handlerParam , eventObj )
{

// Record the "GoToUsedBooksPage" step
var arr = new Array();
_util.Record( "GoToUsedBooksPage", toSafeArray(arr) , 0 );
return true;

}

These functions record Select, GoToAuthorPage, and GoToUsedBooksPage 
on the WebExtBook test object, as planned in “Planning Support for the 
Web Add-in Extensibility Book Sample Toolkit” on page 109.
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Deploying and Testing the Toolkit Support Set

After developing the support for recording on the Book control, you deploy 
the updated toolkit support set to QuickTest and test it.

To test the support for recording operations performed on the Book 
control:

 1 Make sure that your most updated files are located in <QuickTest 
installation folder>\dat\Extensibility\Web\Toolkits\WebExtSample.

 2 Close and reopen QuickTest. Select the check box for WebExtSample in the 
Add-in Manager dialog box and click OK. QuickTest opens and loads the 
support you designed.

 3 Close and rerun the sample control from Start > Programs > QuickTest 
Professional > Extensibility > Samples > Web Add-in Extensibility Book 
Sample. 

 4 Click the Record button or choose Automation > Record. Click on different 
links in the Book control (you must return to the previous page after each 
click, to return to the Book control): the book title, the image in the control, 
an author name, and the Used link.

With each click, a new step is added to the test:

Click the Stop button or choose Automation > Stop to end the recording 
session.
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Stage 9: Implementing Support for Dynamic List of Values 
for AuthorName
Using Web Add-in Extensibility, you can provide the QuickTest user a list of 
possible values to use for a test object method argument, based on the 
run-time values of the specific control. For example, the GoToAuthorPage 
test object method of the WebExtBook test object class receives an 
AuthorName argument. It is easier for the QuickTest users if they can select 
an author name from a list of possibilities instead of typing the name. 
However, this list is different for each WebExtBook control.

In the test object configuration file, you defined the DynamicListOfValues 
attribute for the AuthorName argument as true, instructing QuickTest to 
request the list of possible values from the control when creating a test step.

In the toolkit configuration file, you can specify the file name and function 
name of the JavaScript function that QuickTest must call to retrieve the list 
of values. By default, QuickTest requests the list of values by calling the 
get_list_of_values JavaScript function from the WebExtBook.js file that you 
specified at the Control level for the WebExtBook test object class. QuickTest 
calls the JavaScript function for every argument whose DynamicListOfValues 
attribute is set to true in the test object configuration file. The parameters 
provided to this function indicate the test object method and argument for 
which the values are being requested.

In this section, you implement the get_list_of_values JavaScript function, to 
return the author names from the Book control. 
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To provide a dynamic list of values for the AuthorName argument in the 
GoToAuthorPage test object method:

In the WebExtBook.js file add the JavaScript functions:

// Dynamic list of values implementation
// ~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
function get_list_of_values( method, argIndex )
{

// When creating a step with the GoToAuthorPage test object method, 
// provide a list of the authors of this book, that can be used for the method's 

// argument.
if (method == "GoToAuthorPage")
{

return get_GoToAuthorPage_list_of_values(argIndex);
}

return null;
}

function get_GoToAuthorPage_list_of_values(argIndex)
{

var arr = new Array();
if( argIndex > 1 )

return toSafeArray(arr);

// Retrieve all authors
var AuthorsCount = 0;
for( var i = 0 ; i < _elem.rows[1].cells[0].children.length ; ++i )
{

if( _elem.rows[1].cells[0].children[i].tagName == "A" )
{

arr[AuthorsCount]="\""+_elem.rows[1].cells[0].children[i].innerText+"\"";
AuthorsCount++;

}
}
return toSafeArray(arr);

}

This returns a list of the book’s authors, each enveloped in quotation marks.
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The Book custom control is now fully supported, according to the 
specifications you decided on when planning your custom support.

Note: You can modify the WebExtSample.xml file in the toolkit support set 
folder and then later deploy it to QuickTest for testing, or you can modify 
<QuickTest installation folder>
\dat\Extensibility\Web\Toolkits\WebExtSample\WebExtSample.xml 
directly.

Deploying and Testing the Toolkit Support Set

After implementing the get_list_of_values JavaScript function, you deploy 
the updated toolkit support set to QuickTest and test that the dynamic list of 
author names is properly provided.

To test the support for recording operations performed on the Book 
control:

 1 Make sure that your most updated files are located in <QuickTest 
installation folder>\dat\Extensibility\Web\Toolkits\WebExtSample.

 2 Close and reopen QuickTest. Select the check box for WebExtSample in the 
Add-in Manager dialog box and click OK. QuickTest opens and loads the 
support you designed.

 3 Close and rerun the sample control from Start > Programs > QuickTest 
Professional > Extensibility > Samples > Web Add-in Extensibility Book 
Sample. 

 4 Open a test and create a step with a WebExtBook test object and the 
GoToAuthorPage test object method. The names of the authors displayed 
on the Book control are displayed in a drop-down menu in the Value 
column in the Keyword View.
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Lesson Summary

In this lesson you created a new test object class, WebExtBook, defining its 
identification properties and test object methods. You created support for 
the Book control, enabling QuickTest to recognize it as an WebExtBook test 
object.

➤ You learned to understand the test object configuration file.

➤ You learned to understand the toolkit configuration file.

➤ You learned to support new identification properties and test object 
methods. 

➤ You learned to create a filter for preventing child controls from being 
learned.

➤ You learned to support recording and you made use of the Record and 
RegisterForEvent utility methods.

➤ You learned how to provide a dynamic list of values for a test object 
argument.

Where Do You Go from Here?
For more information on the structure and content of a toolkit support set, 
see “Developing Support for Your Toolkit” on page 59.

For more information on the structure and content of the test object 
configuration file, see the QuickTest Test Object Schema Help (available with 
the Web Add-in Extensibility SDK online Help).

For more information on the structure and content of the toolkit 
configuration file, see the QuickTest Web Add-in Extensibility Toolkit 
Configuration Schema Help (available with the Web Add-in Extensibility SDK 
online Help).

For more information on the _util utility object methods, see the QuickTest 
Web Add-in Extensibility API Reference (available with the Web Add-in 
Extensibility SDK online Help).



Lesson 1 • Learning to Create QuickTest Support for a Simple Custom Web Control

146

In the next lesson you learn how to create support for the Used Books 
custom control. The test object class that represents the Used Books control 
extends the existing WebTable test object class. In developing QuickTest 
support for this control you will learn to use some of the more advanced 
options that Web Add-in Extensibility has to offer.
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2
Learning to Create QuickTest Support for 
a Complex Custom Web Control

In this lesson you create support for the Used Books control in the Web 
Add-in Extensibility Book Sample toolkit. The test object class that 
represents the Used Books control extends the existing WebTable test object 
class. Creating support for the Used Books control teaches you how to use 
some of the more advanced options of Web Add-in Extensibility.

In the lesson “Learning to Create QuickTest Support for a Simple Custom 
Web Control” on page 107, you learned to create support for a simple 
custom control. You are now familiar with the basics of Web Add-in 
Extensibility, therefore this lesson explains only the more advanced 
information.

The <QuickTest Professional Web Add-in Extensibility SDK installation 
folder>\samples\WebExtSample\Toolkit Support Set folder contains a 
complete toolkit support set for this sample to which you can refer while 
you perform this lesson. 

This chapter includes:

 ➤  Preparing for This Lesson on page 148

 ➤  Planning Support for the Web Add-in Extensibility Used Books Control 
on page 149

 ➤  Developing the Toolkit Support Set on page 157

 ➤  Lesson Summary on page 174
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Preparing for This Lesson

Before you extend QuickTest support for a custom control, you must have 
access to its source file. You do not need to modify any of the custom 
control’s sources to support it in QuickTest, but you do need to be familiar 
with them. Make sure you know what elements and attributes comprise the 
control, the events that may occur on this control, and so on. You use this 
information when you design the support.

The source file for the Used Books control is located in <QuickTest 
Professional Web Add-in Extensibility SDK installation 
folder>\samples\WebExtSample\Application\UsedBooks.htm. 

You can run the sample control from Start > Programs > QuickTest 
Professional > Extensibility > Samples > Web Add-in Extensibility Book 
Sample. The Book control opens. In the Book control, click Used to run the 
Used Books control. 

Run the control, open its source file, and study the control’s behavior and 
implementation.

The Used Books control is implemented as a div element that comprises a 
Web table containing information about the available used copies of this 
book and radio buttons, and a Select link (outside the table element) used to 
select a book from the list. Selecting a book and opening the page about the 
selected book (which is not implemented in this sample) requires selecting 
the radio button in the relevant row in the table and then clicking Select. 
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Planning Support for the Web Add-in Extensibility Used 
Books Control

In this section, you analyze how QuickTest currently recognizes the Used 
Books control versus the way it should recognize it, based on your 
knowledge of the control. Next, you determine the answers to the questions 
in the “Understanding the Web Add-in Extensibility Planning Checklist” on 
page 54, and fill in the “Web Add-in Extensibility Planning Checklist” on 
page 155, accordingly.

The best way to do this is to analyze the Used Books control from a 
QuickTest perspective on the one hand using the Object Spy, Keyword View, 
and Record option, and on the other hand, to consider how the control is 
implemented and the purposes for which it is used. 

 1 Open QuickTest and Run the Used Books control.

Open QuickTest and load the Web Add-in.

Close any open instances of the Used Books control and open it by selecting 
Start > Programs > QuickTest Professional > Extensibility > Samples > Web 
Add-in Extensibility Book Sample and then clicking Used in the Book 
control that opens. 

 2 Use the Object Spy to view the Used Books test object methods.

In QuickTest, choose Tools > Object Spy or click the Object Spy toolbar 
button to open the Object Spy dialog box. Click the Methods tab and select 
Test Object Methods. 

In the Object Spy dialog box, click the pointing hand, then click the Used 
Books table. 
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The Used Books control contains a Web table, for which QuickTest support 
is built in, therefore it recognizes the control as a WebTable, named 
according to the title of the table. The icon used for the test object is the 
standard WebTable class icon. QuickTest ignores the div element, which is 
actually the root of the Used Books control.

Close the Object Spy.
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 3 Record operations on the Used Books control.

In QuickTest, choose Automation > Record and Run Settings to open the 
Record and Run Settings dialog box. In the Web tab, select Record and run 
test on any open browser. Click OK.

Click the Record button or choose Automation > Record. In the Used Books 
table, select one of the radio buttons and then click Select.

With each click, a new step is added to the test:

Click the Stop button or choose Automation > Stop to end the recording 
session.

The recorded steps reflect the selection of the radio button and the clicking 
of the link separately, and do not recognize these operations as related to the 
Used Books control. 

 4 Determine the custom toolkit to which the Used Books control belongs.

When you extend QuickTest support for a control you always do so in the 
context of a toolkit. For the purpose of this tutorial, two custom Web 
controls are grouped to form the custom toolkit named WebExtSample: 
Book and UsedBooks.

You created the toolkit support set for this toolkit in the previous lesson. In 
this lesson you add support for the Used Books control in the 
WebExtSample toolkit support set.
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 5 Complete the custom control support planning checklist.

This section describes the required support for the Used Books control, and 
then summarizes the information in the support planning checklist.

 a Choosing the test object class that represents the custom control:

The internal content of the Used Books control is implemented as a Web 
table control because of the type of information it contains. For the 
purpose of performing tests on the Used Books control and checking the 
information it contains, it is appropriate that QuickTest recognize this 
control as a table. However, to optimally support the Used Books control, 
the test object that represents the control must support a SelectBook test 
object method that selects a book from the table by selecting the radio 
button in the correct row in the table, and clicking Select.

In addition, because the first row in the Used Books table contains the 
column names, it would be helpful to replace (or override) the RowCount 
test object method supported for WebTable objects to reduce the row 
count and return the number of used copies available for this book. To 
support the SelectBook test object method and override the 
implementation of RowCount, you create a new test object class named 
WebExtUsedBooks, which extends WebTable. You then teach QuickTest 
to identify this test object class as the one that represents the Used Books 
control.

 b Defining how QuickTest will identify which test object class to use to 
represent the control:

If the following conditions are met, use a WebExtUsedBooks test object 
to represent the control:

➤ The control’s tagName property is div.

➤ The tagName property of the control’s first child is table. 

➤ The className property of the control’s first child is UsedBooks. 

 c Deciding the details for the new test object class:

➤ The new test object class is represented by the icon file: 
<QuickTest installation folder>\dat\Extensibility\Web\Toolkits\
WebExtSample\res\WebBookList.ico

➤ No Help file is provided.
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➤ The WebExtUsedBooks test object class needs to support all of the test 
object methods supported by the WebTable test object class. In addition, 
it needs to support a title identification property (used to uniquely 
identify the control, and selected by default in the checkpoint properties 
dialog box, not used for Smart Identification) and the SelectBook test 
object method.

➤ All of the methods inherited from the base class, WebTable, can be 
supported by the table element contained in the Used Books control. 
However, because the table element is a not the root element of the 
Used Books control, QuickTest does not recognize this element as the 
base element. You must implement a JavaScript function that returns 
the table element as the base element for the Used Books control. This 
instructs QuickTest to use the table element to support the operations 
inherited from the base WebTable test object class.

➤ The SelectBook test object method simulates selecting the radio 
button for the specified book and clicking Select.

➤ The WebTable test object method RowCount needs to be overridden, 
to return the actual number of books in the table instead of the 
number of rows.

➤ The name of the test object itself should be the same as its title 
identification property.

 d Defining which of the control’s children QuickTest should learn when 
learning the control:

For the purpose of this tutorial, when a WebExtUsedBooks test object is 
learned as part of a Web page, the radio buttons within in should be 
learned as well.

 e Deciding whether the Object Spy should display WebExtUsedBooks test 
objects: Yes.

 f Defining whether to support recording, and what events to record:

Listen to mouse clicks that occur on the Select link. When this link is 
clicked, record a test step that selects the book whose radio button is 
selected.  
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 g Deciding what parts of the support need to be designed in the toolkit 
configuration file and what parts need JavaScript functions:

➤ For the Used Books control, test object class identification is performed 
by a JavaScript function, specified in the toolkit configuration file. To 
avoid unnecessary calls to the JavaScript function, a condition element is 
defined in the toolkit configuration file, instructing QuickTest to call the 
JavaScript function only if the control is defined as a div element.

➤ The table base element must be returned by a JavaScript function 
specified in the toolkit configuration file.

➤ Test object identification properties can be supported by JavaScript 
functions using the default naming convention, therefore no changes are 
required in the toolkit configuration file.

➤ The WebTable’s RowCount test object method is overridden by a new 
implementation, provided by a JavaScript function named BookCount. 
Therefore, the name of the function needs to be specified in the toolkit 
configuration file.

➤ Filtering the children that are learned with the Used Books control is 
done by calling a JavaScript function that needs to be specified in the 
toolkit configuration file.

➤ To support recording, you modify the toolkit configuration file to turn 
off the default Web Event Configuration and specify the JavaScript 
function that registers QuickTest to listen to the correct event. In 
addition, you design one JavaScript function that handles event 
registration, and additional JavaScript functions that instruct QuickTest 
to record the relevant steps when the events occur.

Below, you can see the checklist, completed based on the information 
above.
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Web Add-in Extensibility Planning Checklist

Custom Control Support Planning Checklist
Specify in 
Toolkit 
XML?

Support by 
JavaScript 
function?

The sources for this custom control are located in:
<QuickTest Professional Web Add-in Extensibility SDK installation 
folder>\samples\WebExtSample\Application\UsedBooks.htm

n/a n/a

Specify the Web test object base class that the new test object class 
extends: (Default—WebElement)
WebTable

n/a n/a

Is the base test object class WebElement? No

If No, is there a base element (an element that matches the base 
test object class)?Yes

If there is a base element, do you need a JavaScript function to 
return it? Yes

Yes Yes

Specify the New Web test object class details:

➤ Test object class name: WebExtUsedBooks
➤ Icon file location (optional): 

<QuickTest installation folder>\dat\Extensibility\Web\Toolkits\WebE
xtSample\res\WebBookList.ico

➤ Identification properties for description:title
➤ Default test object method:SelectBook
➤ Help file location: n/a

n/a n/a

Specify the basis for identifying the test object class to use for the 
control:
tagName = div
tagName of 1st child = table
className of 1st child = UsedBooks.

Yes Yes

Specify the basis for naming the test object:
Use the Used Books table title

n/a Yes
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List the identification properties to support, and mark which 
should be available (and which selected by default) for 
checkpoints and which (if any) should be used for Smart 
Identification:
title (available for checkpoints and selected by default, not used 
for Smart Identification)

No Yes

List the test object methods to support (if required, include 
arguments, return values, Help file location and Help ID):
SelectBook (BookIndex)

RowCount

Yes Yes

Provide a dynamic list of values for any test object method 
arguments?
No

If so, list the arguments:

n/a No

Specify the types of children that QuickTest should learn with the 
control:
Radio buttons

Yes Yes

Display test objects of this class in the Object Spy?
Yes

No n/a

Provide support for recording? 
Yes

If so, list the events that should trigger recording:

Click on Select

Yes Yes

Custom Control Support Planning Checklist
Specify in 
Toolkit 
XML?

Support by 
JavaScript 
function?



Lesson 2 • Learning to Create QuickTest Support for a Complex Custom Web Control

157

Developing the Toolkit Support Set

Follow the steps in this section to develop the toolkit support set for the 
WebExtSample toolkit and learn more about Web Add-in Extensibility. 
Developing this toolkit support set comprises the following stages:

➤ Stage 1: Expanding the Toolkit Support Set to Support an Additional 
Control, described on page 157

➤ Stage 2: Teaching QuickTest to Identify, Spy, and Learn the Used Books 
Control, described on page 159

➤ Stage 3: Implementing Support for the WebExtUsedBooks’ Test Object 
Methods, described on page 164

➤ Stage 4: Implementing Support for the WebExtUsedBooks’ Identification 
Properties and the Test Object Name, described on page 167

➤ Stage 5: Implementing a Filter to Prevent Learning Child Objects, described 
on page 169

➤ Stage 6: Implementing Support for Recording on the Used Books Control, 
described on page 171

Stage 1: Expanding the Toolkit Support Set to Support an 
Additional Control
To add support for the Used Books control, you first add the definition for 
the WebExtUsedBooks test object class to the 
WebExtSampleTestObjects.xml file.

To expand the toolkit support set to support the Used Books control:

 1 Copy the icon file for the Used Books control, WebBookList.ico, from <Web 
Add-in Extensibility installation folder>\samples\WebExtSample\Toolkit 
Support Set\Toolkits\WebExtSample\res to the <toolkit support set 
folder>\Toolkits\WebExtSample\res folder.
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 2 Add the following definition for the WebExtUsedBooks test object class to 
the WebExtSampleTestObjects.xml file (within the TypeInformation 
element, after the ClassInfo element for the WebExtBook test object class):

<ClassInfo BaseClassInfoName="WebTable" GenericTypeID="Table"
DefaultOperationName="SelectBook" Name="WebExtUsedBooks">
<IconInfo IconFile="INSTALLDIR\dat\Extensibility\Web\Toolkits\

WebExtSample\res\WebBookList.ico"/>
<TypeInfo>

<Operation ExposureLevel="CommonUsed" Name="SelectBook" 
PropertyType="Method">

<Description>Selects the radio button for the specified book and clicks 
Select.</Description>

<Documentation><![CDATA[Select the radio button for the book with 
index %a1 and click Select.]]></Documentation>

<Argument Name="BookIndex" IsMandatory="true" Direction="In">
<Type VariantType="Integer"/>

</Argument>
</Operation>

</TypeInfo>
<IdentificationProperties>

<IdentificationProperty  ForDefaultVerification="true"
ForVerification="true"
ForDescription="true" Name="title"/>

</IdentificationProperties>
</ClassInfo>

This defines the WebExtUsedBooks test object class according to the details 
described in the “Web Add-in Extensibility Planning Checklist” on 
page 155.

For more information on the elements and attributes in the test object 
configuration file, see the QuickTest Test Object Schema Help (available with 
the Web Add-in Extensibility SDK online Help).
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Stage 2: Teaching QuickTest to Identify, Spy, and Learn 
the Used Books Control
After you define the new test object class you must enable QuickTest to 
identify the Web controls for which to use this test object class.

As described in “Planning Support for the Web Add-in Extensibility Used 
Books Control” on page 149, a WebExtUsedBooks test object is used to 
represent a control whose tagName property is div, if the tagName and 
className properties of the control’s first child are table and UsedBooks 
respectively.

For the WebExtUsedBooks test object class, identification is carried out by a 
combination of Condition elements in the toolkit configuration file and a 
JavaScript function.

To define the identification rules for the WebExtUsedBooks test object class:

 1 In the WebExtSample.xml file, within the Controls element, add the 
following Control element for this test object type: 

<Control TestObjectClass="WebExtUsedBooks">
<Settings>

<Variable name="default_imp_file" value="WebExtUsedBooks.js"/>
</Settings>
<Identification type="javascript" function="IsWebExtUsedBooks">

<Conditions type="CallIDFuncIfPropMatch" logic="and">
<Condition prop_name="tagName" expected_value="div"/>

</Conditions>
</Identification>

</Control>

This defines that QuickTest will look for JavaScript functions in the file 
WebExtUsedBooks.js unless another file is specified. The Identification 
element includes one Conditions element that specifies that if the tagName 
property of the control being handled is div (case-insensitive compare), the 
JavaScript function IsWebExtUsedBooks is called to identify whether to use 
this test object class to represent the control. 

 2 In the toolkit support set folder, in the Toolkits\WebExtSample folder, create 
a file named WebExtUsedBooks.js (This is the file for all of the JavaScript 
functions you design to support the Used Books control).
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 3 In WebExtUsedBooks.js, add the following JavaScript function:

function IsWebExtUsedBooks()
{ // Verify that the tagName property is "div" and the className property of the 

// first child (a TABLE element) is "UsedBooks".
var firstChild = _elem.children[0];
if ( _elem.tagName == "DIV" &&

 firstChild.tagName == "TABLE" &&
 firstChild.className == "UsedBooks" )
return true;

return false;
}

This JavaScript function checks whether the control meets the conditions 
that determine that a control should be represented by a WebExtUsedBooks 
test object.

Deploying and Testing the Toolkit Support Set

After defining the WebExtUsedBooks test object class in the test object 
configuration file and the identification rules for this test object class in the 
toolkit configuration file and JavaScript functions, you can test the effect of 
using the toolkit support set with QuickTest. 

To test the toolkit support set:

 1 Deploy the test object configuration file, toolkit configuration file, icon file, 
and JavaScript file to their correct locations within the QuickTest 
installation folder.

 2 Open QuickTest and load the WebExtSample support (select it in the Add-in 
Manager dialog box).

 3 Run the sample control from Start > Programs > QuickTest Professional > 
Extensibility > Samples > Web Add-in Extensibility Book Sample and click 
Used. 
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Note: QuickTest establishes its connection with an application when the 
application opens. Therefore, if the Used Books control is open, you must 
close it and run it again. 

 4 Perform the following QuickTest options on the Used Books control, to see 
how QuickTest recognizes the control:

➤ Use the Object Spy to view the test object properties and test object methods 
that are supported for the Used Books control. No value is displayed for the 
title property because you have not yet implemented a JavaScript function 
that returns its value. 

The test object created for the Used Books control is given the name of its 
test object class, and uses the custom icon you defined. Later in this lesson, 
you customize your toolkit support set to provide a more specific name.



Lesson 2 • Learning to Create QuickTest Support for a Complex Custom Web Control

162

The WebExtUsedBooks test object includes all of the test object methods of 
a WebTable test object, as well as the Select method that you defined in the 
test object configuration file.

➤ Use the Add Objects to Local button in the Object Repository dialog box to 
learn the Used Books control. The custom icon is used to represent the test 
object in the object repository.

➤ In the Keyword View, create a test step choosing the WebExtUsedBooks 
object from the object repository in the Item column.
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➤ The list of available operations in the Operation column reflects the 
definitions in the test object configuration file. All of the test object 
methods supported by WebTable test objects are available, because in the 
test object configuration file, you defined that the WebExtUsedBooks test 
object extends (and therefore inherits from) the WebTable test object 
class.

➤ After you choose an operation, the Value cell is partitioned according to 
the number of arguments of the selected operation. For example, when 
you create a step with the operation SelectBook, the value cell requires 
one argument and displays the argument’s Name attribute in a tooltip. 

➤ The descriptions and documentation strings you defined for test object 
methods in the test object configuration file are displayed in tooltips and 
in the Documentation column, respectively.

➤ In the Expert View, create a test step with a WebExtBook test object. 
Intellisense displays all of the operations available for the test object, 
including the ones inherited from WebTable. 

For more information on working with these options in QuickTest, see the 
HP QuickTest Professional User’s Guide.

 5 Run a test with a step that performs the SelectBook test object method on a 
WebExtUsedBooks test object. QuickTest searches for a JavaScript function 
that will run the test object method on the control. Because you have not 
yet implemented support for running test object methods, a run-time error 
occurs. In the next section, you implement this support.
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Stage 3: Implementing Support for the 
WebExtUsedBooks’ Test Object Methods
In the test object configuration file you defined the test object methods 
available for WebExtUsedBooks test objects. For QuickTest to run these test 
object methods, the methods must actually be implemented.

You must provide implementation for different types of test object methods:

➤ Test object methods inherited from the WebTable base test object class

➤ Test object methods added for the new test object class

➤ Test object methods inherited from the base class that need to be 
implemented differently

Implementing Test Object Methods Inherited from WebTable

In the test object configuration file, you defined that the WebExtUsedBooks 
test object class extends the base class WebTable. For the inherited WebTable 
test object methods that you do not override, QuickTest can use its internal 
implementation by interacting with the table base element defined within 
the Used Books control. Because the table element is not the root level of 
the Used Books control, you must inform QuickTest that the table element 
is the base element. To do this you must write a JavaScript function that 
returns the base element, and specify its name in the toolkit configuration 
file.

To instruct QuickTest to use the table Web element as the base element:

 1 In the WebExtSample.xml file, within the Settings element that you defined 
in the Control element for the WebExtUsedBooks test object class, add the 
following Variable element: 

<Control TestObjectClass="WebExtUsedBooks">
<Settings>

<Variable name="func_to_get_base_elem" value="GetTableElem"/>
</Settings>

</Control>

This instructs QuickTest to call a JavaScript named GetTableElem (in the file 
WebExtUsedBooks.js) to return the base element that supports the inherited 
WebTable test object methods. 
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 2 In the WebExtUsedBooks.js file, add the following JavaScript function:

function GetTableElem()
{

// Get the <table> element (the first child of the <div> element which is the 
// root of the Used Books control)
return _elem.children[0];

}

This JavaScript function returns the table element, which is the first element 
within the div element that defines the Used Books control. This element 
supports the test object methods inherited from WebTable that are not 
implemented by WebExtUsedBooks. 

Other JavaScript functions that you write in this file can also use the 
GetTableElem() function to access the table element in the Used Books 
control.

Implementing the New Test Object Method SelectBook

To support the SelectBook test object method for the WebExtUsedBooks test 
object class, write the SelectBook JavaScript function in 
WebExtUsedBooks.js. This is the function that QuickTest calls to run the 
SelectBook test object method. It simulates selecting the radio button for 
the specified book, and clicking Select.

Add the following JavaScript function to the WebExtUsedBooks.js file:

function SelectBook( BookIndex )
// Select the radio button for the specified index and clicks the "Select" link.
{

if( BookIndex > BookCount() )
throw "Book index is out of range !"

// Select the radio button corresponding to the specified  index
GetTableElem().rows[1+BookIndex].cells[0].children[0].click();
// Click the "Select" link (the 3rd child of the <div> element)
_elem.children[2].click();
// Add a log message to the Event Viewer to assist in debugging
_util.LogLine("Book Selected",1);

}
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Overriding the Implementation of the Inherited Test Object 
Method RowCount

 1 In the WebExtSample.xml file, add the following Run element within the 
Control element that defines the WebExtUsedBooks support.

<Run>
<Methods>

<Method name="RowCount" type="javascript"
function="BookCount" />

</Methods>
</Run>

This defines that the RowCount test object method is implemented by the 
JavaScript function BookCount.

 2 In the WebExtUsedBooks.js file, add the BookCount JavaScript function, 
which decreases the row count of the Used Books control, to return the 
number of books in the table: 

function BookCount()
// This function overrides the RowCount test object method inherited from 
// WebTable, so that it counts only book rows.
{

var table = GetTableElem();
if( table.rows.length < 2 )

return 0;
return table.rows.length - 2;

}

Deploying and Testing the Toolkit Support Set

After you develop support for running the test object methods, you deploy 
the updated toolkit support set to QuickTest and test it.

To test the support for running test object methods:

 1 To deploy the updated toolkit support set to QuickTest, copy the 
WebExtUsedBooks.js file (and WebExtSample.xml if necessary) to 
<QuickTest installation folder>
\dat\Extensibility\Web\Toolkits\WebExtSample.
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 2 Close and reopen QuickTest. Select the check box for WebExtSample in the 
Add-in Manager dialog box and click OK. QuickTest opens and loads the 
support you designed.

 3 Close and rerun the sample control from Start > Programs > QuickTest 
Professional > Extensibility > Samples > Web Add-in Extensibility Book 
Sample. Click Used.

 4 Use the Add Objects to Local button in the Object Repository dialog box to 
learn the Used Books control.

 5 Create a test that runs the SelectBook and RowCount methods and make 
sure they perform correctly.

Stage 4: Implementing Support for the 
WebExtUsedBooks’ Identification Properties and the Test 
Object Name
In the WebExtUsedBooks.js file, implement the get_property_value as 
follows:

function get_property_value(prop)
// The function provides values for all of the identification properties defined in
// the test object configuration XML file, as well as the hard coded "logical_name"
// property that QuickTest uses to name the test object.
{

if ( prop == "logical_name" || prop == "title" )
// For the "title" identification property, as well as the "logical_name"
// property, return the inner text of the first cell in the first row
{

return GetTableElem().rows[0].cells[0].innerText;
}

}

This function returns the title of the object for the title property, as well as 
for the test object name.
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Note: You can modify the WebExtUsedBooks.js file in the toolkit support set 
folder and then later deploy it to QuickTest for testing, or you can modify 
<QuickTest installation folder>\dat\Extensibility\Web\Toolkits\
WebExtSample\WebExtUsedBooks.js directly.

Deploying and Testing the Toolkit Support Set

After you develop support for retrieving run-time values of identification 
properties, you deploy the updated toolkit support set to QuickTest and test 
it.

To test the support for retrieving run-time values of identification 
properties:

 1 Make sure that your most updated files are located in <QuickTest 
installation folder>\dat\Extensibility\Web\Toolkits\WebExtSample.

 2 Close and reopen QuickTest. Select the check box for WebExtSample in the 
Add-in Manager dialog box and click OK. QuickTest opens and loads the 
support you designed.

 3 Close and rerun the sample control from Start > Programs > QuickTest 
Professional > Extensibility > Samples > Web Add-in Extensibility Book 
Sample. Click Used.

 4 Create a new test, add a WebExtUsedBooks test object to your object 
repository, and create a test step with this test object. Make sure that the test 
object name is based on the table’s title. Right-click the object and select 
Insert Standard Checkpoint. The Checkpoint Properties dialog box opens. 
Make sure that the title identification property you defined in the test object 
configuration file is included in the list of properties and selected.

 5 Create and run a test that retrieves each identification property and checks 
its value, or displays it in a message box. 
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Stage 5: Implementing a Filter to Prevent Learning Child 
Objects
In this section, you create a filter to prevent QuickTest from learning all of 
the Used Books control’s children along with the control.

You implement this in the toolkit configuration file and in the JavaScript 
file.

To filter the children learned with the Used Books control:

 1 In the WebExtSample.xml file, within the Control element defined for the 
WebExtBook test object class, add the following Filter element:

<Filter>
<Learn learn_control="Yes" learn_children="CallFilterFunc" 

type="javascript" function="GetChildrenToLearn" />
</Filter>

This instructs QuickTest to learn WebExtUsedBooks test objects when 
learning their parent Web pages, and to call the JavaScript function 
GetChildrenToLearn to determine which children to learn. The JavaScript 
function returns a SafeArray of the controls descendants that should be 
learned with the control.

Note: You can modify the WebExtSample.xml file in the toolkit support set 
folder and then later deploy it to QuickTest for testing, or you can modify 
<QuickTest installation folder>
\dat\Extensibility\Web\Toolkits\WebExtSample\WebExtSample.xml 
directly.
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 2 In the WebExtUsedBooks.js file, add the following functions:

// Learn filtering
// This function instructs QuickTest which child objects of a UsedBooksTable 
// should be learned with the object is learned. 

function GetChildrenToLearn()
{ // Return all of the radio buttons in the used books table

return toSafeArray(GetTableElem().getElementsByTagName("input") );
}

This ensures that only the radio buttons are learned, as planned in the 
outset of this lesson. 

Deploying and Testing the Toolkit Support Set

After defining the filter to customize learning children, you deploy the 
updated toolkit support set to QuickTest and test it.

To test the support for learning the WebExtUsedBooks test object without 
its children:

 1 Make sure that your most updated files are located in <QuickTest 
installation folder>\dat\Extensibility\Web\Toolkits\WebExtSample.

 2 Close and reopen QuickTest. Select the check box for WebExtSample in the 
Add-in Manager dialog box and click OK. QuickTest opens and loads the 
support you designed.

 3 Close and rerun the sample control from Start > Programs > QuickTest 
Professional > Extensibility > Samples > Web Add-in Extensibility Book 
Sample. Click Used.

 4 Open a test and open the Object Repository. Use the Add Objects to Local 
button in the Object Repository dialog box to learn the Web page that 
contains the Used Books control. The Define Object Filter dialog box opens.

 5 Select All object types and click OK. The WebExtUsedBooks object named 
The History of QuickTest is added to the object repository, as is the 
SelUsedBook radio button group. However, none of the other element 
contained in the control are learned.
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Stage 6: Implementing Support for Recording on the Used 
Books Control
In this section, you implement support for recording on the Used Books 
control.

 1 In the WebExtSample.xml file, and the following Record element within the 
Control element that defines the WebExtUsedBooks class:

<Record>
<EventListening use_default_event_handling_for_children="false"

use_default_event_handling="false" 
type="javascript" function="ListenToEvents"/>

</Record>

This instructs QuickTest not to use the default Web Event Configuration to 
record events on the Used Books control, but to call the ListenToEvents 
JavaScript function instead.

In the WebExtUsedBooks.js file add the ListenToEvents JavaScript function:

function ListenToEvents( elem )
{// Connect to the "Select" event: 
//When "Select" is clicked, call OnSelectUsedBooksClicked.

_util.RegisterForEvent
(_elem.children[2], "onclick", "OnSelectUsedBooksClicked" );

return true;
}

This function registers QuickTest to listen to clicks on the Select link, and 
call the appropriate event handler when the event occurs.
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 2 In the WebExtUsedBooks.js file add the OnSelectUsedBooksClicked event 
handling JavaScript function:

function OnSelectUsedBooksClicked( handlerParam , eventObj )
{

var arr = new Array();
var booksCount = BookCount();
// Find the index of the selected radio button and record a step that runs the  
// SelectBook test object method with that index 
var BookIndex = -1;
for( var i = 0 ; i < booksCount ; i++ )
{

if( _elem.rows[2+i].cells[0].children[0].status == true )
{ // This is the selected item

arr[0] = i+1;
_util.Record( "SelectBook", toSafeArray(arr) , 0 );
_util.LogLine("SelectBook Recorded",1);
break;

}
}
return true;

}

This function checks which book’s radio button is selected, and instructs 
QuickTest to record a step selecting that book (and add the relevant log 
message to the Event Viewer).

Deploying and Testing the Toolkit Support Set

After developing the support for recording on the Used Books control, you 
deploy the updated toolkit support set to QuickTest and test it.

To test the support for recording operations performed on the Used Books 
control:

 1 Make sure that your most updated files are located in <QuickTest 
installation folder>\dat\Extensibility\Web\Toolkits\WebExtSample.

 2 Close and reopen QuickTest. Select the check box for WebExtSample in the 
Add-in Manager dialog box and click OK. QuickTest opens and loads the 
support you designed.
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 3 Close and rerun the sample control from Start > Programs > QuickTest 
Professional > Extensibility > Samples > Web Add-in Extensibility Book 
Sample. Click Used.

 4 Click the Record button or choose Automation > Record. In the Used Books 
table, select one of the radio buttons and then click Select.

A new step is added to the test only after you click Select:

Click the Stop button or choose Automation > Stop to end the recording 
session.

The Book custom control is now fully supported, according to the 
specifications you decided on when planning your custom support.
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Lesson Summary

In this lesson you created a test object class, WebExtUsedBooks, that extends 
the WebTable test object class. You created support for the Used Books 
control, enabling QuickTest to recognize it as an WebExtUsedBooks test 
object.

➤ You learned to understand more options in the toolkit configuration file.

➤ You learned to implement the support using more complex JavaScript 
functions and specifying their location in the toolkit configuration file. 

Where Do You Go from Here?
Now that you have performed the lessons in this tutorial, you are ready to 
apply the Web Add-in Extensibility concepts and the skills you learned to 
creating your own custom toolkit support.

For more information on the structure and content of a toolkit support set, 
see “Developing Support for Your Toolkit” on page 59.

For more information on the structure and content of the test object 
configuration file, see the QuickTest Test Object Schema Help (available with 
the Web Add-in Extensibility SDK online Help).

For more information on the structure and content of the toolkit 
configuration file, see the QuickTest Web Add-in Extensibility Toolkit 
Configuration Schema Help (available with the Web Add-in Extensibility SDK 
online Help).

For more information on the _util utility object methods, see the QuickTest 
Web Add-in Extensibility API Reference (available with the Web Add-in 
Extensibility SDK online Help).
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